
 

 

 

TALLERES DE AUTOFORMACIÓN CON 

PROGRAMAS INFORMÁTICOS DE 

ANÁLISIS DE REDES SOCIALES  

Águeda Quiroga (UPF), Joel Martí (UAB), Isidro 

Maya Jariego (US), José Luis Molina (UAB) 

Borrador - Septiembre 2005 

 

 



 2

ÍNDICE 

PRESENTACIÓN 4 

OPERACIONES BÁSICAS CON UCINET 6  5 

CÓMO INTRODUCIR DATOS DE RELACIONES (RETICULARES) 5 

Hoja de datos 5 

Fichero de texto 7 

CÓMO CONVERTIR MATRICES DE MODO 2 EN MATRICES DE MODO 1 8 

Completar filas o columnas 8 

Afiliaciones 12 

CÓMO RECODIFICAR MATRICES 16 

EL ANÁLISIS DE REDES SOCIOCÉNTRICAS CON UCINET 6 Y NETDRAW 19 

INTRODUCCIÓN 19 

DESCRIPCIÓN DEL EJERCICIO PRÁCTICO 21 

CREAR UNA MATRIZ CON UCINET 6 22 

GRAFICAR UNA RED CON NETDRAW 27 

MEDIDAS DE CENTRALIDAD 34 

Grado nodal (degree) 35 

Grado de intermediación (betweenness) 39 

Cercanía (closenness) 41 

Redes dentro de redes: cliques 43 

Cliques 44 

N-clique, N-clan y k-plex 50 

El ANÁLISIS DE REDES PERSONALES CON EGONET Y VISUALIZER 62 

NOTAS SOBRE LA INSTALACIÓN DE EGONET 64 

MÓDULO ADMINISTRADOR (EGONET_QB) 65 

Questions about Ego 67 

Name genearator(s) 70 

Questions about alters 71 

Alter tie evaluation 72 

MÓDULO CLIENTE (EGONET) 73 

LA ENTREVISTA CUALITATIVA CON VISUALIZER 78 

Clusters o Grupos de la Red Personal 80 

Grado de Intermediación 82 

Composición: Sexo, Residencia y Otras 83 

BIBLIOGRAFÍA 88 

EL ANÁLISIS DINÁMICO DE REDES CON SIENA- 89 

EL PROGRAMA SIENA: ESPECIFICACIONES DEL MODELO 90 

LOS PRIMEROS PASOS CON SIENA: UNA SESIÓN DE TRABAJO CON EL 
PROGRAMA 93 



 3

UN EJEMPLO DE APLICACIÓN DEL PROGRAMA: LA EVOLUCIÓN DE LOS 
INTERCAMBIOS EN UNA LISTA DE CORREO ELECTRÓNICO 104 

BIBLIOGRAFÍA 108 

APÉNDICE I. MATRICES UTILIZADAS EN EL APARTADO LOS PRIMEROS PASOS 
CON SIENA 110 

EL ANÁLISIS DEL DISCURSO CON VISONE 111 

EL ANÁLISIS RETICULAR DE TEXTOS 111 

EL PROGRAMA VISONE 113 

Panorámica General del Programa 113 

Cómo Crear Sociogramas y Modificar el Aspecto de Nodos y Vínculos 115 

CREACIÓN DE UNA RED DISCURSIVA CON VISONE 116 

Configuración general 116 

Dibujando Nodos y Vínculos 117 

VISUALIZACIÓN Y ANÁLISIS DE LA RED 119 

Análisis básicos 119 

Más posibilidades 122 

SALIDAS Y EXPORTACIÓN DE RESULTADOS 124 

BIBLIOGRAFÍA 127 



 4

PRESENTACIÓN 
Este manual intenta llenar un espacio hasta ahora cubierto de forma 

incompleta: el de la autoformación en las diferentes aplicaciones del Análisis 

de redes sociales. Los textos teóricos disponibles en castellano empiezan a 

ser ya suficientes para disponer de una introducción. Sin embargo, los 

talleres y las matrices de datos, tanto reticulares como atributivos, están 

limitados prácticamente al web REDES (www.redes-sociales.net).  

Cada capítulo tiene la voluntad de ser un taller autosuficiente. Es por ello 

que en ocasiones se pueden encontrar informaciones redundantes, pero 

siempre necesarias para la realización de la práctica propuesta.  

Evidentemente este manual está pensado para Windows XP. 
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OPERACIONES BÁSICAS CON UCINET 6 1 

La experiencia nos enseña que las dificultades para el análisis de redes 

sociales residen, más que en cuestiones conceptuales o teóricas, en el 

aprendizaje de la mecánica de la transformación de datos. Este capítulo está 

dedicado a la realización de unas pocas prácticas que permitirán con toda 

seguridad moverse ágilmente por la variedad de posibilidades analíticas del 

programa.  

CÓMO INTRODUCIR DATOS DE RELACIONES 

(RETICULARES) 

Existen dos formas de introducir datos en Ucinet 6. La primera es 

directamente en una hoja de datos; la segunda es mediante un fichero de 

texto. Veamos cada una de ellas.  

HOJA DE DATOS 

En la Ilustración 1 puede verse el botón que permite activar la matriz de 

datos de Ucinet 6. 

Spreadsheet

 

Ilustración 2. La hoja de datos (spreadsheet) de Ucinet 6 

Esta matriz es útil para introducir pocos nodos de una forma rápida. Una 

vez clicado el botón indicado haremos la práctica de introducir una red de 

solamente 5 nodos para experimentar las diferentes posibilidades. Lo 

primero que haremos será seleccionar la opción de datos simétricos (esto es, 

                                            

1 Autor: José Luis Molina (Departament d’antropologia social i cultural, UAB). 
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que si A tiene relación con B, B también tiene relación con A) para 

introducir fácilmente las etiquetas de los nodos.  

 

Ilustración 3. Hoja de datos de Ucinet 6. 

A continuación clicaremos en la celda seleccionada y escribiremos los 

siguientes nombres: Penélope, Tom, Nikole, Melanie, Antonio. Una vez 

escritos copiaremos estas etiquetas de las filas a las columnas con el 

comando:  

Labels>Copy rows to columns 

A continuación indicaremos con un “1” si son o han sido (o han dicho que 

han sido) pareja estable. Como la matriz es simétrica sólo es necesario que 

indiquemos que Penélope tiene un “1” con Tom, Tom un “1” con Nikole y 

Melanie un “1” con Antonio. Con el comando  

Fill>Missings with simmetric counterparts 

rellenaremos los “1” que faltaban y con el comando  

Fill>Blanks w/ 0s 

rellenaremos con “0” las celdas en blanco. Por último, solamente nos queda 

guardar la matriz en un fichero: 

File>Save As>prueba 
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Ilustración 4. Guardar la matriz generada en la hoja de datos 

Con esto ya tenemos generada una matriz de datos lista para ser analizada. 

El nombre asignado por Ucinet 6 será  

prueba.##h 

La hoja de datos de Ucinet 6 es compatible con la opción de copiar y pegar de 

Excel, por lo que en ocasiones puede ser útil trabajar en esa hoja de cálculo, 

abrir la hoja de datos de Ucinet y pegar la matriz seleccionada previamente. 

En este caso tenemos que tener cuidado que no queden filas ni columnas en 

blanco, indicando en el apartado correspondiente el número exacto de 

ambas. 

FICHERO DE TEXTO 

Cuando se recogen datos de investigaciones, la lista de nodos suele ser de 

decenas o centenas. Por tanto, es mucho más práctico recoger los datos en 

un formato del tipo 
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Penélope Tom 1 
Tom Nikole 1 
etc. 

Ucinet 6 dispone de muchos tipos de formato para los ficheros de texto, pero 

el más útil es el siguiente: 

dl n = 5 format = el1 
labels embedded 
data: 
Penélope Tom 1 
Tom Penélope 1 
Tom Nikole 1 
Nikole Tom 1 
Melanie Antonio 1 
Antonio Melanie 1 

De esta forma se indica a Ucinet 6 cada una de las relaciones. Si copiamos 

estas instrucciones en un fichero de texto y lo guardamos como prueba2.txt 

podremos importarlo a Ucinet 6 de la siguiente forma: 

Data>Import>DL>prueba2.txt 
El resultado es el mismo que hemos obtenido con la hoja de datos. Ucinet 

crea un fichero llamado  

Prueba2.##h 

 

CÓMO CONVERTIR MATRICES DE MODO 2 EN 

MATRICES DE MODO 1 

COMPLETAR FILAS O COLUMNAS 

A menudo nos encontramos con matrices de modo 2 que tienen que ser 

convertidas en matrices de modo 1 para permitir algunos análisis. Las 

matrices de modo 2 resultan, por ejemplo, cuando los respondientes citan 

nombres libremente, sin escogerlos de una lista. Así tenemos en las filas los 

respondientes y en las columnas los nominados, que no suelen coincidir.  

Vamos a suponer que tenemos una encuesta por barrios a jóvenes 

barceloneses sobre dónde van a divertirse por la noche. Tendríamos una 
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matriz del tipo barrio A  barrio B. No todos los barrios reciben jóvenes, por 

lo que la lista de barrios de las filas no coincide con la lista de barrios de las 

columnas. También puede ser que se queden en el barrio, por lo que nos 

interesan las relaciones reflexivas.  

Así tenemos un matriz de 10 barrios en las filas y de 24 barrios y otras 

poblaciones en las columnas. Los números indican el número de jóvenes que 

se desplazan. 

 A B C D E F G H I J K L M N Ñ O P Q R S T U V W 
A 24 4 0 0 1 4 1 0 0 1 3 0 1 0 0 0 4 0 0 0 1 2 0 0

B 44 29 1 0 5 20 0 0 0 2 11 1 2 3 0 0 1 0 0 0 2 1 1 0

C 28 5 10 1 0 5 1 0 0 1 6 4 4 1 1 1 4 0 0 0 10 2 0 1

D 8 4 3 19 4 8 0 0 0 0 1 3 1 0 0 0 0 0 0 0 1 1 0 0

E 14 6 0 0 18 17 1 0 0 0 2 3 2 0 0 0 0 0 0 0 1 0 0 2

F 6 8 0 0 1 26 0 0 0 1 4 2 0 0 1 0 0 0 0 0 1 2 1 1

G 23 8 2 1 2 16 5 2 0 0 6 3 2 3 8 1 1 0 0 0 1 2 0 0

H 18 8 0 1 1 3 2 24 2 5 9 0 3 0 3 3 0 4 1 0 7 6 1 1

I 16 4 0 1 2 6 0 1 9 1 9 1 3 1 0 2 0 0 0 0 2 3 5 2

J 26 11 0 0 4 10 0 1 4 5 22 1 4 2 1 1 3 1 1 1 2 6 0 2

Tabla 1. Número de jóvenes que se trasladan para divertirse entre barrios de una 

ciudad y poblaciones anejas 

El fichero de datos es el siguiente (página siguiente): 
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DL 

NR=10, NC=24 
FORMAT = FULLMATRIX DIAGONAL PRESENT 
ROW LABELS: 
"A" 
"B" 
"C" 
"D" 
"E" 
"F" 
"G" 
"H" 
"I" 
"J" 
ROW LABELS EMBEDDED 
COLUMN LABELS: 
"A" 
"B" 
"C" 
"D" 
"E" 
"F" 
"G" 
"H" 
"I" 
"J" 
"K" 
"L" 
"M" 
"N" 
"Ñ" 
"O" 
"P" 
"Q" 
"R" 
"S" 
"T" 
"U" 
"V" 
"W" 
COLUMN LABELS EMBEDDED 
LEVEL LABELS: 
"Page 1" 
DATA: 
  "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "Ñ" "O" "P" "Q" "R" "S" "T" 
"U" "V" "W" 
"A" 24  4  0  0  1  4  1  0  0  1  3  0  1  0  0  0  4  0  0  0  1  2  0  0 
"B" 44 29  1  0  5 20  0  0  0  2 11  1  2  3  0  0  1  0  0  0  2  1  1  0 
"C" 28  5 10  1  0  5  1  0  0  1  6  4  4  1  1  1  4  0  0  0 10  2  0  1 
"D"  8  4  3 19  4  8  0  0  0  0  1  3  1  0  0  0  0  0  0  0  1  1  0  0 
"E" 14  6  0  0 18 17  1  0  0  0  2  3  2  0  0  0  0  0  0  0  1  0  0  2 
"F"  6  8  0  0  1 26  0  0  0  1  4  2  0  0  1  0  0  0  0  0  1  2  1  1 
"G" 23  8  2  1  2 16  5  2  0  0  6  3  2  3  8  1  1  0  0  0  1  2  0  0 
"H" 18  8  0  1  1  3  2 24  2  5  9  0  3  0  3  3  0  4  1  0  7  6  1  1 
"I" 16  4  0  1  2  6  0  1  9  1  9  1  3  1  0  2  0  0  0  0  2  3  5  2 
"J" 26 11  0  0  4 10  0  1  4  5 22  1  4  2  1  1  3  1  1  1  2  6  0  2 

 

Seleccionemos esos datos y copiémoslos en un fichero de texto con nombre 

“jovenes.txt”. Desde Ucinet 6 realizaremos la importación: 
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Data>Import>DL 

Hay que tener cuidado que el nombre del fichero aparezca como el producto 

de la exportación en el subdirectorio adecuado.  

Abriremos la hoja de datos y cargaremos el fichero importado. A 

continuación cambiaremos las filas a 24 y copiaremos las etiquetas de las 

columnas en las filas. Por último, rellenaremos con ceros las celdas en 

blanco y guardaremos una matriz de modo 1 con un nombre nuevo. El 

resultado debería ser el siguiente: 

 

Ilustración 5. Matriz de modo 1 de 24 x 24 barrios o localidades 

En este momento podemos hacer un primer análisis, por ejemplo con 

Netdraw y obtener una imagen de los desplazamientos de los jóvenes.  
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Ilustración 6. Desplazamientos nocturnos de jóvenes. 

La escala de grises indica la proporción de jóvenes que salen de un barrio. El 

tamaño del nodo indica la proporción de jóvenes que visitan un barrio y el 

grosor de la línea la proporción de desplazamientos. Los nodos aislados 

indican que tienen muy pocos jóvenes con esta conducta Parece claro que el 

barrio A recibe la mayor parte de las visitas nocturnas … 

Para usar las potencialidades de Netdraw consultar el capítulo 

correspondiente.   

AFILIACIONES 

En ocasiones nos interesa conservar la matriz de modo 2 y hacer una 

análisis de filas por filas o de columnas por columnas. El caso típico consiste 

en el análisis hecho por Davis et. al. (1941) de un grupo de mujeres y los 

eventos sociales a los que asistieron. La matriz de modo 2 es la siguiente: 



 13

DL 
NR=18, NC=14 
FORMAT = FULLMATRIX DIAGONAL PRESENT 
ROW LABELS: 
"EVELYN" 
"LAURA" 
"THERESA" 
"BRENDA" 
"CHARLOTTE" 
"FRANCES" 
"ELEANOR" 
"PEARL" 
"RUTH" 
"VERNE" 
"MYRNA" 
"KATHERINE" 
"SYLVIA" 
"NORA" 
"HELEN" 
"DOROTHY" 
"OLIVIA" 
"FLORA" 
ROW LABELS EMBEDDED 
COLUMN LABELS: 
"E1" 
"E2" 
"E3" 
"E4" 
"E5" 
"E6" 
"E7" 
"E8" 
"E9" 
"E10" 
"E11" 
"E12" 
"E13" 
"E14" 
COLUMN LABELS EMBEDDED 
DATA: 
          "E1" "E2" "E3" "E4" "E5" "E6" "E7" "E8" "E9" "E10" "E11" "E12" "E13" "E14" 
 "EVELYN" 1 1 1 1 1 1 0 1 1 0 0 0 0 0 
  "LAURA" 1 1 1 0 1 1 1 1 0 0 0 0 0 0 
"THERESA" 0 1 1 1 1 1 1 1 1 0 0 0 0 0 
 "BRENDA" 1 0 1 1 1 1 1 1 0 0 0 0 0 0 
"CHARLOTTE" 0 0 1 1 1 0 1 0 0 0 0 0 0 0 
"FRANCES" 0 0 1 0 1 1 0 1 0 0 0 0 0 0 
"ELEANOR" 0 0 0 0 1 1 1 1 0 0 0 0 0 0 
  "PEARL" 0 0 0 0 0 1 0 1 1 0 0 0 0 0 
   "RUTH" 0 0 0 0 1 0 1 1 1 0 0 0 0 0 
  "VERNE" 0 0 0 0 0 0 1 1 1 0 0 1 0 0 
  "MYRNA" 0 0 0 0 0 0 0 1 1 1 0 1 0 0 
"KATHERINE" 0 0 0 0 0 0 0 1 1 1 0 1 1 1 
 "SYLVIA" 0 0 0 0 0 0 1 1 1 1 0 1 1 1 
   "NORA" 0 0 0 0 0 1 1 0 1 1 1 1 1 1 
  "HELEN" 0 0 0 0 0 0 1 1 0 1 1 1 0 0 
"DOROTHY" 0 0 0 0 0 0 0 1 1 0 0 0 0 0 
 "OLIVIA" 0 0 0 0 0 0 0 0 1 0 1 0 0 0 
  "FLORA" 0 0 0 0 0 0 0 0 1 0 1 0 0 0 
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De nuevo seleccionamos los datos anteriores y los copiamos en un fichero de 

texto. Este fichero lo importamos desde Ucinet (DL). Esta matriz de 18 

mujeres en las filas y 14 eventos sociales en las columnas puede ser 

analizada de forma que obtengamos una matriz de mujeres por mujeres (18 

x 18) y una matriz de eventos por eventos (14 x 14). En cada caso el análisis 

nos permitirá identificar grupos de mujeres o de eventos, mujeres o eventos 

centrales o periféricos, en fin, obtener medidas estructurales sobre las 

relaciones. 

Para ello seleccionamos en Ucinet 6  

Data>Affiliations 

En la ventana de diálogo que aparece a continuación (Ilustración 7), 

seleccionamos el fichero Ucinet importado y elegimos si queremos obtener la 

nueva matriz a partir de las filas (“Row”) o partir de las columnas 

(“Column”, en el desplegable). 

 

Ilustración 8. Ventana de diálogo de comando "Afiliaciones" 

Si elegimos “Row” obtendremos un fichero llamado Affiliations.##h de 18 x 

18 listo con la siguiente matriz: 
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                                 1 1 1 1 1 1 1 1 1 
               1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 
               E L T B C F E P R V M K S N H D O F 
               - - - - - - - - - - - - - - - - - - 
  1    EVELYN  8 6 7 6 3 4 3 3 3 2 2 2 2 2 1 2 1 1 
  2     LAURA  6 7 6 6 3 4 4 2 3 2 1 1 2 2 2 1 0 0 
  3   THERESA  7 6 8 6 4 4 4 3 4 3 2 2 3 3 2 2 1 1 
  4    BRENDA  6 6 6 7 4 4 4 2 3 2 1 1 2 2 2 1 0 0 
  5 CHARLOTTE  3 3 4 4 4 2 2 0 2 1 0 0 1 1 1 0 0 0 
  6   FRANCES  4 4 4 4 2 4 3 2 2 1 1 1 1 1 1 1 0 0 
  7   ELEANOR  3 4 4 4 2 3 4 2 3 2 1 1 2 2 2 1 0 0 
  8     PEARL  3 2 3 2 0 2 2 3 2 2 2 2 2 2 1 2 1 1 
  9      RUTH  3 3 4 3 2 2 3 2 4 3 2 2 3 2 2 2 1 1 
 10     VERNE  2 2 3 2 1 1 2 2 3 4 3 3 4 3 3 2 1 1 
 11     MYRNA  2 1 2 1 0 1 1 2 2 3 4 4 4 3 3 2 1 1 
 12 KATHERINE  2 1 2 1 0 1 1 2 2 3 4 6 6 5 3 2 1 1 
 13    SYLVIA  2 2 3 2 1 1 2 2 3 4 4 6 7 6 4 2 1 1 
 14      NORA  2 2 3 2 1 1 2 2 2 3 3 5 6 8 4 1 2 2 
 15     HELEN  1 2 2 2 1 1 2 1 2 3 3 3 4 4 5 1 1 1 
 16   DOROTHY  2 1 2 1 0 1 1 2 2 2 2 2 2 1 1 2 1 1 
 17    OLIVIA  1 0 1 0 0 0 0 1 1 1 1 1 1 2 1 1 2 2 
 18     FLORA  1 0 1 0 0 0 0 1 1 1 1 1 1 2 1 1 2 2 

 

Un simple análisis de f-Groups (una técnica que busca grupos 

internamente densos y débilmente conectados que está disponible en 

Network>Subgroups>f-Groups) de esta matriz nos muestra la existencia 

de dos grupos de mujeres bien definidos: 

Group 1: 
 EVELYN LAURA THERESA BRENDA CHARLOTTE FRANCES ELEANOR RUTH 
Group 3: 
 VERNE MYRNA KATHERINE SYLVIA NORA HELEN 
Levels of Ties Among Actors 
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                                 1 1 1 1 1 1 1 1 1 
               1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 
               E L T B C F E P R V M K S N H D O F 
               - - - - - - - - - - - - - - - - - - 
  1    EVELYN  2 2 2 2 1 2 1 1 1 1 1 1 1 1 1 1 1 1 
  2     LAURA  2 2 2 2 1 2 2 1 1 1 1 1 1 1 1 1 0 0 
  3   THERESA  2 2 2 2 2 2 2 1 2 1 1 1 1 1 1 1 1 1 
  4    BRENDA  2 2 2 2 2 2 2 1 1 1 1 1 1 1 1 1 0 0 
  5 CHARLOTTE  1 1 2 2 2 1 1 0 1 1 0 0 1 1 1 0 0 0 
  6   FRANCES  2 2 2 2 1 2 1 1 1 1 1 1 1 1 1 1 0 0 
  7   ELEANOR  1 2 2 2 1 1 2 1 1 1 1 1 1 1 1 1 0 0 
  8     PEARL  1 1 1 1 0 1 1 2 1 1 1 1 1 1 1 1 1 1 
  9      RUTH  1 1 2 1 1 1 1 1 2 1 1 1 1 1 1 1 1 1 
 10     VERNE  1 1 1 1 1 1 1 1 1 2 1 1 2 1 1 1 1 1 
 11     MYRNA  1 1 1 1 0 1 1 1 1 1 2 2 2 1 1 1 1 1 
 12 KATHERINE  1 1 1 1 0 1 1 1 1 1 2 2 2 2 1 1 1 1 
 13    SYLVIA  1 1 1 1 1 1 1 1 1 2 2 2 2 2 2 1 1 1 
 14      NORA  1 1 1 1 1 1 1 1 1 1 1 2 2 2 2 1 1 1 
 15     HELEN  1 1 1 1 1 1 1 1 1 1 1 1 2 2 2 1 1 1 
 16   DOROTHY  1 1 1 1 0 1 1 1 1 1 1 1 1 1 1 2 1 1 
 17    OLIVIA  1 0 1 0 0 0 0 1 1 1 1 1 1 1 1 1 2 1 
 18     FLORA  1 0 1 0 0 0 0 1 1 1 1 1 1 1 1 1 1 2  

Ilustración 9. Análisis de F-Groups de Ucinet 6 

Por otra parte, un análisis de las columnas también puede sernos de 

utilidad. Procederíamos de la misma forma pero seleccionando “Column” en 

lugar de “Row”.  

CÓMO RECODIFICAR MATRICES  

Ucinet 6 dispone de un amplio conjunto de procedimientos para manipular 

matrices. De todos ellos destacaremos la opción  

Transform>Recode 

Este procedimiento consta de dos partes (pestaña “Files” y pestaña “Recode”, 

Ilustración 10 ). En la pestaña Files, podemos seleccionar el fichero con los 
datos, las filas y las columnas que queremos recodificar. El botón L nos 

permite seleccionar diferentes subconjuntos de filas o columnas, 

presionando la tecla Crtl y clicando las etiquetas de fila o columna 

correspondientes. Si no especificamos nada, la remodificación afectará a 

toda la matriz.  
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Ilustración 10. Opción "Recode" de Ucinet 6 

Por último, en la pestaña Recode podemos especificar un conjunto de reglas 

de recodificación. Siguiendo con el ejemplo de los jóvenes que se mueven en 

la noche barcelonesa, podemos introducir el criterio de convertir en “0” todos 

los desplazamientos de menos de 15 jóvenes y en “1” todos los 

desplazamientos de 15 o superior. Así: 

 

 

Ilustración 11. Recodificación de los valores de una matriz 

Si clicamos la tecla Add dispondremos de las dos reglas definidas. El 

resultado de la recodificación (matriz Recjovenes) es el siguiente: 
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                         1 1 1 1 1 1 1 1 1 1 2 2 2 2 2 
       1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7 8 9 0 1 2 3 4 
       A B C D E F G H I J K L M N Ñ O P Q R S T U V W 
       - - - - - - - - - - - - - - - - - - - - - - - - 
  1 A  1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  2 B  1 1 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  3 C  1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  4 D  0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  5 E  0 0 0 0 1 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  6 F  0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  7 G  1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  8 H  1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
  9 I  1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 10 J  1 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 

Si representamos gráficamente la matriz con NetDraw obtendremos una 

imagen bastante parecida a la que obtuvimos en la Ilustración 6. 

 

Ilustración 12. Grafo de la matriz recodificada de traslado nocturno de jóvenes en 

Barcelona 
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EL ANÁLISIS DE REDES SOCIOCÉNTRICAS CON 

UCINET 6 Y NETDRAW2 

INTRODUCCIÓN  

Este taller tiene como objetivo introducir conceptos básicos del análisis de 

datos reticulares (o análisis de redes sociales), utilizando UCINET 6 y 

NetDraw3. Los contenidos de este manual surgen de tres fuentes 

principales:   

 Hanneman, Robert A., Introducción a los métodos de análisis de redes 

sociales. Departamento de Sociología de la Universidad de California 

Riverside. 

http://wizard.ucr.edu/~rhannema/netwprks/text/textindex.html 

Versión en castellano en http://www.redes-sociales.net/materiales.  

 Molina, José Luis (2001), El análisis de redes sociales. Una 

introducción. Barcelona: Edicions Bellaterra.  

 Wasserman, Stanley and Faust, Katherine (1994), Social network 

Analysis. Methods and Applications. Cambridge MA: Cambridge 

University Press.  

Pero ¿qué es el análisis de redes sociales? Veamos una definición:  

El análisis de redes sociales se ocupa del estudio de las relaciones entre una 

serie definida de elementos (personas, grupos, organizaciones, países e 

incluso acontecimientos).  A diferencia de los análisis tradicionales que 

explican, por ejemplo, la conducta en función de la clase social y la profesión, 

el análisis de redes sociales incorpora las relaciones y no sólo los atributos de 

los elementos. (Molina, op.cit: p. 13). 

                                            

2 Autora: Águeda Quiroga (UPF).  
3 Borgatti, S.P. 2002. NetDraw: Graph Visualization Software. Harvard: Analytic 
Technologies http://www.analytictech.com.  
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La particularidad del análisis de redes sociales radica entonces en el énfasis 

en las relaciones entre los elementos estudiados, entre sus propiedades 

relacionales, y no exclusivamente en las características monádicas 

(atributos individuales) de cada elemento.   

Como señala Hanneman (op.cit), los datos sociológicos “tradicionales” se 

representan en una matriz rectangular en donde se inscriben las 

mediciones. En las filas se ubican los casos u observaciones (personas, 

organizaciones, países, etc.), y en las columnas, las variables seleccionadas 

(edad, tipo de organización, población, etc.). En cambio, en el análisis de 

redes sociales  

(…) los datos de la ‘red’ (en su forma más pura), constituyen una matriz 

cuadrada de mediciones. Las filas de la matriz son los casos, sujetos u 

observaciones. Las columnas son el mismo conjunto de casos, sujetos y 

observaciones –allí está la diferencia clave con los datos convencionales. En 

cada celda de la matriz se describe una relación entre los actores. (p. 5)  

  

Informante  Edad  Sexo  Ocupación  
FFG  32  Mujer  Secretaria administrativa  

BNM  20  Hombre  Estudiante  
DFP  45  Hombre  Funcionario público  
CCD  37  Mujer  Abogada 
STR  26  Mujer  Docente  

Tabla 2. Matriz con datos sociológicos “convencionales” 

¿Quién es amigo de quién?  
  FFG  BNM  DFP  CCD  STR  
FFG  -  1  0  0  1  
BNM  1  -  1  0  0  
DFP  0  1  -  1  1  
CCD  0  0  1  -  0  
STR  1  0  1  0  -  

Tabla 3. Matriz con datos relacionales 

En las Tablas 2 y 3 se presenta un ejemplo de los dos tipos de matrices 

señaladas por Hanneman. La primera se fija en las características de los 

individuos. La segunda, en las relaciones que mantienen dichos individuos 
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entre sí. Así, se ha marcado con 1 la presencia de la relación de amistad y 

con 0 su ausencia.  

Los elementos básicos del análisis de redes sociales son, entonces, los nodos 

(los puntos que representan a personas, grupos, países, etc.) y la relación o 

vínculo que nos interesa analizar (amistad, enemistad, parentesco, comercio, 

etc.) y que se establece entre tales nodos.  

DESCRIPCIÓN DEL EJERCICIO PRÁCTICO  

Comenzaremos trabajando con un ejemplo sencillo, a fin de introducir los 

conceptos básicos. Analizaremos las relaciones de conocimiento mutuo de un 

curso de estudiantes universitarios. Contamos con el listado de estudiantes 

(nombre y sexo) y la carrera a la que pertenecen. Además, cada uno de ellos 

ha respondido un cuestionario en el que se les preguntaba a quiénes de los 

demás integrantes de la clase conocían personalmente antes de iniciar el 

curso.  

Así, los nodos serán en este caso los estudiantes, y el vínculo a analizar será 

la relación de conocimiento previo. Conviene precisar bien a qué propiedad 

relacional nos referimos. No se trataba en este caso de preguntar quiénes 

eran amigos de quiénes, ni de si algún estudiante tenía conocimiento 

indirecto de otro (ambos casos resultan problemáticos por diversas razones). 

Se trata de la propiedad “conocer a”, que en nuestro estudio (y en el 

cuestionario) se entendía como tener un mutuo conocimiento personal (que 

no tiene por qué implicar relación continuada, pero sí alguna interacción 

pasada). Con los datos de las tablas 4 y 5 elaboraremos las matrices que 

utilizaremos para el análisis  

 Nombre  Sexo (M/F) Carrera 
Andrés  M Antropología 
Carlos  M Arqueología 
Carme  F Arqueología 
Carmen  F Antropología 
Carol  F Arqueología 
Dolors  F Antropología 
Hugo  M Sociología 
Joan  M Antropología 
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José  M Psicología Social 
Julio  M Antropología 
Liliana  F Sociología 
María  F Psicología Social 
Mariano  M Arqueología 
Martha  F Arqueología 
Nuria  F Psicología Social 
Pau  M Antropología 
Xavi  M Psicología Social 

Tabla 4. Listado de estudiantes 

 Nombre  Conoce a  
Andrés  Carlos, Carmen, Dolors, Joan, Julio, Pau  
Carlos  Carme, Carol, Andrés  
Carme  Carlos, Carol  
Carmen  Andrés, Dolors, Pau  
Carol  Carlos, Carme  
Dolors  Andrés, Carmen, José  
Hugo  Liliana  
Joan  Andrés, Julio, Pau, José  
José  Dolors, Joan, María, Nuria, Xavi  
Julio  Andrés, Joan  
Liliana  Hugo  
María  José, Nuria, Xavi  
Mariano  Martha, Pau  
Martha  Mariano, Pau  
Nuria  José, María  
Pau  Andrés, Carmen, Joan, Martha, Mariano  
Xavi  José, María  

Tabla 5. Resultado del cuestionario 

CREAR UNA MATRIZ CON UCINET 6  

El primer paso en nuestro análisis de redes del ejemplo planteado consiste 

en construir una matriz con la información de que disponemos, a fin de 

poder analizarla y graficarla. Para eso, utilizaremos el programa Ucinet 6.  

Al iniciar dicho programa Ucinet 6 nos encontramos con la siguiente 

pantalla:  
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Ilustración 13. Ucinet 6 

Al operar en un entorno Windows, el programa presenta características 

comunes a los programas elaborados para este sistema operativo. Cuenta 

con una barra de menús desplegables (File, Data, Transform, Tools, 

Network, Draw, Options, Help) más una serie de iconos de acceso directo. Si 

nos fijamos en la figura 13, veremos que en la parte inferior hay un 

rectángulo blanco, donde se lee “C:\Documents and 

Settings\Propietario\Mis documentos”. Esta dirección nos indica el 

directorio en el que estamos trabajando, y en el que por defecto guardará los 

archivos. Para definir otra carpeta o directorio se debe hacer seleccionar  

File> Change Default Folfer 

Esta operación es importante hacerla en primer lugar.  

A continuación debemos introducir nuestros datos. Para ello activaremos la 

función “Spreadsheet” (el segundo icono desde la izquierda, ver la 

Ilustración 2 y siguientes). 

Antes de continuar con la introducción de datos en la matriz es conveniente 

realizar una aclaración sobre los tipos de vínculos. Los lazos o vínculos 
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pueden ser orientados o no orientados (por ejemplo, conocimiento previo 

como una relación no orientada, prestar dinero a alguien como una relación 

orientada). Pero, por otra parte, también pueden ser o binarios o valorados. 

Son binarios cuando medimos la ausencia o presencia de la relación. En el 

caso que estamos analizando, si dos personas se conocen previamente le 

damos el valor 1 y si no, 0. Pero también podríamos querer valorar el tipo de 

relación que tienen dos personas, ponderando el vínculo, por ejemplo, entre 

0 si no hay conocimiento, 1 si son apenas conocidos, 2 si son conocidos con 

una relación continuada, 3 si son amigos y 4 si son amigos muy cercanos. A 

lo largo de este ejemplo sólo trabajaremos con vínculos no orientados y 

binarios, pero es importante recordar que se pueden utilizar también 

vínculos orientados y vínculos valorados, y que dentro de estos existe una 

gran pluralidad de variantes4. 

Dado que, como hemos dicho, en nuestro ejemplo los vínculos no son 

orientados, cambiaremos la función a “Symmetric” (Ilustración 3) e 

introduciremos los nombres de los estudiantes en las filas y luego los 

copiaremos en las columnas  

Labels> Copy rows to columns 

                                            

4 Para más información sobre los tipos de vínculos y las escalas de medida, véase 
Hanneman, op.cit, cap 1:17-22. 
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Ilustración 14. Hoja de datos con los estudiantes 

Hemos introducido ya los nodos de la red que queremos analizar. A 

continuación introduciremos los valores de la relación. Así, siguiendo la 

información de la tabla 5, introduciremos manualmente la información 

correspondiente a cada par de personas. Introduciremos un 1 si hay relación 

y dejaremos la celda en blanco si no la hay:  

 

Ilustración 15. Relación existente entre los estudiantes (conocimiento previo) 
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Una vez completa nos ubicaremos en la última celda (en este caso, en la 

intersección de la columna 17 con la fila 17) y desde allí haremos  

Fill> Blanks w/0s 

De esta manera, se completarán con ceros el resto de las celdas de la matriz:  

Hemos completado así la matriz con las relaciones. La guardaremos con el 

nombre “estudiantes” (a partir del menú File> Save as).  

A continuación crearemos dos nuevas matrices, en las que almacenaremos 

los datos atributivos de la Tabla 4 (sexo y carrera a la que pertenecen los 

estudiantes). Recordemos que los datos atributivos son propiedades 

individuales, y por lo tanto no relacionales, de los nodos que son objeto de 

nuestro análisis. Para ellos, abriremos la matriz que acabamos de crear 

(File>Open>estudiantes.##h) y realizaremos nuevamente la operación 

“Save as”. Llamaremos “carrera” a este nuevo fichero (File>Save 

as>carrera).   

Introduciremos en esta matriz (carrera.##h) los datos correspondientes a la 

carrera universitaria que estudian los alumnos de la clase. Para aprovechar 

el listado de los nombres, eliminaremos la información de las columnas. 

Seleccionamos con el ratón las 17 columnas y apretamos la tecla “Suprimir” 

o “Delete”:  

Una vez borrada la información de las columnas, cambiaremos el modo de la 

matriz a “Normal” (esta matriz ya no será cuadrada como la anterior, sino 

que tendrá 17 filas y 1 columna). Escribimos en el encabezado de la columna 

1 (en la zona coloreada debajo del número 1) “carrera” (sin las comillas). 

Introduciremos en esa columna la información codificada de la siguiente 

manera: 1 para los estudiantes de antropología, 2 para los de arqueología, 3 

para los de sociología y 4 para los de Psicología social:  
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Ilustración 16. Datos atributivos de los estudiantes (carrera) 

Guardamos la matriz y elegimos “yes” en la opción guardar cambios.  

A continuación, abrimos la matriz que acabamos de crear 

(File>Open>carrera.##h) y la guardamos con el nombre “sexo” (File>Save 

as>sexo). Realizamos sobre esta matriz la misma operación que en el caso 

anterior (borramos la columna 1) y escribimos como encabezado de la misma 

“sexo” (sin comillas) e introducimos la información codificada de la siguiente 

manera: 1 para varones y 2 para mujeres. 

Cerramos la matriz y guardamos los cambios. Hemos introducido ya toda la 

información que utilizaremos en este taller.  

GRAFICAR UNA RED CON NETDRAW 

A continuación, veremos la representación gráfica de la primera matriz que 

hemos creado, la que resume la información sobre las relaciones existentes 

entre los estudiantes.  

Una vez cerrada la función “Spreadsheet”, regresamos a la pantalla inicial 

de Ucinet 6. Allí hacemos un click sobre el icono que abre el programa 

NetDraw (el séptimo icono contando desde la izquierda). Se abre así una 

ventana con el programa NetDraw. Este programa se utiliza para visualizar 
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gráficamente redes sociales. Veremos representada en grafos la matriz que hemos 

introducido. Para ello, abriremos la matriz “estudiantes.##h” que hemos creado 

anteriormente desde: 

File>Open>Ucinet dataset>Network 

Al abrirla obtenemos el siguiente gráfico:  

  

 

Ilustración 17. Red de los estudiantes con NetDraw 

Vemos representadas gráficamente las relaciones que habíamos introducido 

en la matriz. Así, por cada par de personas que habíamos conectado en la 

matriz (mediante el 1 que señalaba la relación) observamos un vínculo que 

une los dos nodos. Como se trata de una relación no orientada, cada grafo 

tiene una doble flecha (Hugo conoce a Liliana y Liliana conoce a Hugo). Un 

grafo no orientado también se representa como un segmento que une dos 

nodos, sin ninguna flecha que indique dirección.  

Esta red sociométrica presenta una fotografía de las relaciones que existen 

al interior de un grupo (la clase, en este caso). A simple vista podemos 

observar que existen individuos más conectados que otros, que existen sub-
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grupos dentro de la red, etc. Podríamos entonces intentar establecer 

hipótesis acerca de las relaciones existentes. Por ejemplo, podríamos 

suponer que las personas que cursan las mismas carreras se relacionan más 

entre sí que las de carreras diferentes. Para ello, necesitamos complementar 

la información con los datos atributivos que hemos recopilado.  

Para ello, añadiremos la matriz que contiene la información sobre las 

carreras a la matriz que representaba las relaciones de conocimiento y que 

ya hemos realizado. La operación es muy sencilla. Sin salir de la red de 

estudiantes (Ilustración 17) realizamos: 

File>Open>Ucinet dataset>Attribute Data 

Y seleccionamos el fichero “carrera.##h”.  

 

Ilustración 18. Red de estudiantes y la información sobre sus estudios 

Veremos los cuatro códigos que hemos introducido para las carreras, cada 

uno de ellos asociado a un color diferente. Si quisiéramos cambiar el color 

adjudicado a alguno, sólo hay que hacer click sobre el rectángulo de color 

que se encuentra a la izquierda del código y seleccionar el color que 

deseamos en la paleta que se despliega. En este caso, cambiaremos el color 

correspondiente al código 2, de negro a verde:  
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Ilustración 19. Cambiando los colores de las categorías de la variable atributiva 

"carrera" 

Una vez efectuado el cambio, hacemos click sobre el botón “Aceptar”. Vemos 

entonces que a cada persona le corresponde el color de la carrera que está 

estudiando: rojo para Antropología, verde para Arqueología, azul para 

Sociología y gris para Psicología Social.  
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Ilustración 20. Representación de la red con el atributo correspondiente 

A continuación, introduciremos los datos correspondientes al sexo, 

utilizando formas diferentes para los nodos, según representen hombres o 

mujeres. Introducimos entonces la matriz correspondiente al sexo 

(sexo.##h). Y seleccionamos la función “Choose node shapes according to 

attribute values” (tercer icono contando desde la derecha). Se abrirá una 

ventana similar a la que utilizamos para definir los colores. Seleccionamos 

el atributo “sexo”. Un consejo: si en el menú desplegable (“select attibute”) 

no vemos el atributo que queremos introducir, debemos descender hacia el 

final de la ventana, hasta encontrarlo.  

A continuación seleccionaremos un triángulo para identificar a los hombres 

(codificados con el valor “1”) y un círculo para identificar a las mujeres 

(codificadas con el valor “2”):  
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Ilustración 21. Variable atributiva "sexo" 

De esta manera hemos introducido los dos atributos en la red. Y obtenemos 

el siguiente resultado:  

 

Ilustración 22. Red social con indicación del sexo (forma) y los estudios (color) 
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Hemos conseguido una descripción más detallada de la red de interacciones. 

Como podemos observar en la Ilustración 22, existen subgrupos en el 

interior de nuestra red así como personas con más conexiones que otras. Así, 

los que cursan la carrera de Antropología (marcados en rojo) se conocían 

todos entre sí antes de iniciar el curso. Lo mismo pasa con los estudiantes de 

Psicología Social (nodos grises) y los de Sociología (nodos azules). Sin 

embargo, no sucede lo mismo con los estudiantes de Arqueología (verde), 

entre los que podemos observar dos grupos diferenciados. Por el contrario, 

no parece haber ningún patrón diferenciado de relación entre hombres y 

mujeres.  

En lo que hace a las personas, algunos estudiantes sólo conocen a una o dos 

personas del grupo, mientras que otras (como Andrés o Joan) conocen a 

mucha gente. Pero para saber con certeza cuáles son las características de 

esta red, recurriremos al cálculo de las medidas de centralidad, a fin de 

realizar una primera aproximación al análisis de esta red social. Antes de 

pasar a esta sección, exportaremos la imagen de la red que hemos obtenido, 

para poder utilizarla posteriormente. Para ello, desde la función “File” de la 

barra de menús seleccionamos la función “Save diagram as” y luego el 

formato que elijamos (en este caso, “Bitmap”)  

 

Ilustración 23. Guardando la red como imagen 
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La guardaremos con el nombre “redestudiantes”. Para concluir la primera 

parte de la práctica, crearemos un documento en Word (con el nombre 

“informe práctica.doc”) e insertaremos la imagen que hemos creado 

(Insertar>Imagen>Desde archivo):  

 

 

Ilustración 24. Insertando una red en Word 

Seleccionamos la imagen a insertar (“redestudiantes”), y guardamos los 

cambios realizados en el informe. 

MEDIDAS DE CENTRALIDAD  

 Como señala Hanneman (op.cit.),  

La perspectiva de redes implica tener en cuenta múltiples niveles de análisis. 

Las diferencias entre los actores son interpretadas en base a las limitaciones 

y oportunidades que surgen de la forma en que éstos están inmersos en las 

redes; la estructura y el comportamiento de las redes está basado en y 

activado por las interacciones locales entre los actores. (...) Las diferencias en 

cómo los individuos están conectados puede ser extremadamente útil para 

entender sus atributos y comportamiento. Muchas conexiones significan a 

menudo que los individuos se exponen todavía a más y más diversa 

información. (cap V: p. 3)  
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Podemos realizar una primera aproximación a la estructura de una red 

social mediante el análisis de tres medidas de centralidad: rango (degree), 

grado de intermediación (betweenness) y cercanía (closeness). Por medida de 

centralidad se entiende un conjunto de algoritmos calculado sobre cada red 

que nos permite conocer la posición de los nodos en el interior de la red y la 

estructura de la propia red. Veamos qué significa cada una de estas 

medidas, cómo se calculan y cómo se interpretan.  

GRADO NODAL (DEGREE)  

El grado nodal o rango es el número de lazos directos de un actor (o nodo), es 

decir con cuántos otros nodos se encuentra directamente conectado. Si 

volvemos a la figura 23, por ejemplo, podemos observar que Martha está 

conectada a dos personas: Mariano y Pau. Su rango, entonces es 2. Andrés, 

en cambio, conoce a seis personas: su rango es 6. En este caso es sencillo 

calcularlo a simple vista. Pero para trabajar con mayor precisión, 

utilizaremos Ucinet 6. Desde el menú “Network” seleccionaremos la función 

“Centrality” y luego “Degree”:  

 

Ilustración 25. Calculando el grado nodal (Degree) con Ucinet 6 
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 En la pantalla que se despliega seleccionaremos la matriz que contiene los 

datos que queremos analizar. En este caso, analizaremos la matriz 

“estudiantes.##h”, la que contiene la información sobre las relaciones de 

conocimiento entre los estudiantes de la clase. Para ello, haremos click con 

el ratón en el botón de la fila “imput dataset” (marcado con tres puntos):  

 

Ilustración 26. Seleccionando el fichero "estudiantes" 

La primera fila (“Input dataset”) indica el fichero que utilizará para calcular 

el rango. La segunda fila (“Treat data as symmetric”) pregunta si se trata de 

una matriz simétrica (la relación de A-B vale para B-A) o no. En este caso, la 

respuesta es “sí”. La tercera fila (Include diagonal values?) pregunta si debe 

tener en cuenta los valores de la diagonal (la relación entre A y A, B y B, C y 

C, etc.), y responderemos “no”. La cuarta fila informa con qué nombre se 

guardarán los resultados, en el directorio que tengamos predeterminado. 

Haciendo click en el icono de los tres puntos, se puede definir otro directorio 

y modificar el nombre del archivo con los datos de salida si así lo deseamos. 

Una vez realizados los cambios que queremos hacer, hacemos click en 

“aceptar”. Obtenemos la siguiente pantalla:  
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Ilustración 27. Resultados del cálculo del grado nodal 

 Vemos la lista de todos los nodos de la red, ordenados de mayor rango (más 

número de conexiones) a menor rango (menor número de conexiones). Se 

reproduce a continuación la información obtenida en las tres primeras 

columnas:   

  Degree NrmDegree 
Andrés  6.0 37.500 
Pau  5.0 31.250 
José  5.0 31.250 
Joan  4.0 25.000 
Carlos  3.0 18.750 
Dolors  3.0 18.750 
Carmen  3.0 18.750 
María  3.0 18.750 
Carme  2.0 12.500 
Nuria  2.0 12.500 
Carol  2.0 12.500 
Mariano  2.0 12.500 
Xavi  2.0 12.500 
Julio  2.0 12.500 
Martha  2.0 12.500 
Liliana  1.0 6.250 
Hugo  1.0 6.250 
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La columna “Nrmdegree” indica el rango normalizado, es decir, el porcentaje 

de conexiones que tiene un nodo sobre el total de la red.  

El análisis del rango o grado nodal nos indica que la persona más conectada 

en este grupo, la de mayor centralidad, es Andrés, y que Liliana y Hugo son 

los menos centrales, con un rango de 1 cada uno. Podríamos suponer que 

Andrés es la persona que controla mayor cantidad de información. El grado 

nodal puede ser considerado una medida que permite acceder al índice de 

accesibilidad a la información que circula por la red. Si, por ejemplo, en el 

interior del grupo circularan ciertos rumores, los actores con un grado nodal 

más alto tendrán mayores probabilidades de escucharlos y difundirlos. El 

rango también puede ser interpretado como el grado de oportunidad de 

influir o ser influido por otras personas en la red. Pongamos por ejemplo el 

caso de la red que estamos analizando. Supongamos que nos interesa 

realizar algunas modificaciones en el dictado de la asignatura o que 

queremos conocer la valoración de los estudiantes sobre su desarrollo. En 

este caso Andrés (con un grado nodal de 6, el más alto de la red) parece ser 

un buen informante, alguien que tiene acceso a bastante información de la 

que circula por el grupo. Podemos utilizar el rango también, por ejemplo, 

como un método de selección de personas para entrevistas o negociaciones.  

Pero debemos complementar este análisis con las otras medidas de 

centralidad, para obtener un panorama más completo. Antes de hacerlo, nos 

referiremos a los estadísticos descriptivos que acompañan la información:  
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Ilustración 28. Estadísticos descriptivos del cálculo del grado nodal 

Los estadísticos descriptivos brindan información sobre los valores que tomó 

el rango en el conjunto de la red. Vemos que el rango promedio de la red 

(“Mean”) es 2.824, y que los valores oscilan entre 1 y 6 (la menor y mayor 

cantidad de lazos).   

Incorporaremos esta información al informe de la práctica, de manera muy 

sencilla: seleccionamos con el ratón el texto y seleccionamos la función 

“copiar” (Edit>Copy). Pegamos la información en el informe en Word que 

estamos elaborando (Edición>Pegar).  

GRADO DE INTERMEDIACIÓN (BETWEENNESS)  

El grado de intermediación indica la frecuencia con que aparece un nodo en 

el tramo más corto (o geodésico) que conecta a otros dos. Es decir, muestra 

cuando una persona es intermediaria entre otras dos personas del mismo 

grupo que no se conocen entre sí (lo que podríamos denominar “persona 

puente”). Veamos cuáles son los valores para el grado de intermediación en 

nuestra red para localizar un ejemplo.  

Para calcular el grado de intermediación seleccionamos el menú 

Network>Centrality>Betweenness>Nodes:   



 40

En la pantalla que se despliega elegimos la matriz que contiene los datos 

que vamos a analizar (“estudiantes.##h”) y hacemos click en el botón “ok”. 

Obtenemos como resultado el valor del grado de intermediación de cada 

nodo, ordenados de mayor a menor:  

 

Ilustración 29. Resultados del cálculo del grado de intermediación 

 Se reproducen a continuación los resultados obtenidos:  

  Betweenness nBetweenness 
Andrés  39.0 32.5 
José  34.0 28.3 
Joan  25.5 21.2 
Pau  24.5 20.4 
Carlos  24.0 20.0 
Dolors  12.0 20.0 
Carmen  1.5 10.0 
María  0.5 1.2 
Carme  0.0 0.4 
Hugo  0.0 0.0 
Carol  0.0 0.0 
Liliana  0.0 0.0 
Mariano  0.0 0.0 
Julio  0.0 0.0 
Nuria  0.0 0.0 
Martha  0.0 0.0 
Xavi  0.0 0.0 
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Andrés y José son las personas con un mayor grado de intermediación. Si 

observamos la figura 23 vemos que Andrés es la persona que conecta al 

grupo de los antropólogos con uno de los grupos de los arqueólogos (el 

formado por Carlos, Carme y Carol) y José conecta al grupo de los 

estudiantes de psicología social con los de antropología. Pero Joan, Pau y 

Carlos también tienen valores altos de grado de intermediación. La relación 

entre Joan y Pau permite conectar tres grupos: arqueólogos, antropólogos y 

psicólogos sociales. En el caso de Carlos, su relación con Andrés vincula a 

Carol y Carme con un grupo mayor. Si esa relación se rompiese, el grupo 

quedaría aislado.  

Realizaremos la misma operación que en el caso del rango: seleccionaremos 

los resultados obtenidos y con la función “copiar” incorporaremos la 

información en el documento del informe.  

CERCANÍA (CLOSENNESS)  

El grado de cercanía indica la cercanía de un nodo respecto del resto de la 

red. Representa la capacidad que tiene un nodo de alcanzar a los demás. 

Veremos su interpretación a partir de un ejemplo.  

Para calcularlo, procederemos de la misma manera que en las dos medidas 

de centralidad anteriores, es decir, a partir del menú “Network” 

(Network>Centrality>Closenness). Seleccionamos el archivo a analizar 

y damos click en el botón “ok”. El resultado de la operación, al igual que en 

los casos anteriores, es la lista ordenada de los valores de cercanía, y 

también el de su opuesto, lejanía (farness):  
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Ilustración 30. Cálculo de la cercanía 

Se reproducen a continuación los resultados:  

  Farness Closeness 
Andrés  59.0 27.11 
Joan  60.0 26.66 
Pau  62.0 25.80 
Dolors  63.0 25.39 
José  64.0 25.00 
Carmen  64.0 25.00 
Julio  67.0 23.88 
Carlos  68.0 23.52 
Mariano  74.0 21.62 
Martha  74.0 21.62 
Maria  75.0 21.33 
Nuria  76.0 21.05 
Xavi  76.0 21.05 
Carme  80.0 20.0 
Carol  80.0 20.0 
Liliana  256.0 6.25 
Hugo  256.0 6.25 

 

Al igual que en las dos medidas de centralidad anteriormente analizadas, 

Andrés es la persona de la red que cuenta con un grado de cercanía más 

grande. Tiene una mayor capacidad para acceder al resto de los nodos de la 
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red. Sin embargo, los resultados para el resto de las personas no son iguales 

a los obtenidos en las mediciones anteriores. Si volvemos a los resultados del 

grado nodal vemos que, por ejemplo, Dolors tenía el mismo rango que 

Carlos, Carmen y María (conocían a tres personas cada uno). Sin embargo, 

el grado de cercanía de Dolors es mayor que el de ellos. No sólo es 

importante el número de personas que conoces, sino quiénes son esas 

personas, cuál es su grado de conexiones. Si observamos la red vemos que 

Dolors conoce a Andrés y a José, las dos personas con mayor grado de 

cercanía de toda la red. De esta manera, su probabilidad de acceder al resto 

de los nodos es más alta. “Una persona poco conectada con el resto (baja 

centralidad, bajo grado de intermediación) por el solo hecho de estar 

conectada con una persona ‘importante’ puede tener una alta cercanía” 

(Molina, op.cit: p. 79).  

Finalizaremos ahora el ejercicio, copiando los resultados y llevándolos al 

informe que hemos elaborado.  

REDES DENTRO DE REDES: CLIQUES  

 Regresemos ahora al gráfico de nuestra red. Una característica que 

podemos observar a simple vista es que dentro de ella es posible identificar 

grupos o sub-grafos. Por ejemplo, Carlos, Carme y Carol constituyen un 

grupo: están relacionados entre ellos (de hecho, tienen se encuentran más 

vinculados entre ellos que con el resto de la red). Este subgrupo recibe el 

nombre técnico de clique (si bien, como veremos posteriormente, podríamos 

hablar de dos acepciones de clique: en sentido “duro” y en sentido “blando”). 

Un clique (en sentido “blando”) es un grupo dentro de una red.   

El análisis de sub-grafos, o de cliques, es un tipo de aproximación a la 

estructura de la red, una aproximación de “abajo hacia arriba”, como señala 

Hanneman (op. cit.):  

La noción [de clique] parte de los vínculos simples para “construir” la red. Un 

mapa de toda la red puede ser construido examinando los tamaños de los 

distintos cliques y agrupaciones de tipo de clique, notando sus tamaños y 
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yuxtaposiciones. Este tipo de aproximación, acerca de las subestructuras de 

las redes, tienden a enfatizar cómo lo macro puede surgir de lo micro. Tienden 

a enfocar nuestra atención primero en los individuos y en entender cómo 

están inmersos en la estructura mayor de la red a partir de los grupos 

yuxtapuestos. Esta idea aparentemente obvia se tiene que destacar porque 

también es posible aproximarse a la cuestión de la subestructuras de las 

redes desde una perspectiva de arriba hacia abajo. Ambos aspectos son 

valiosos y complementarios. (cap V: p. 6)  

Ucinet permite analizar las subestructuras de la red, a partir de una serie de 

medidas de agrupamiento, que revisaremos a continuación  

CLIQUES  

Hemos utilizado anteriormente la palabra clique como sinónimo de 

subgrupo dentro de una red. Pero en sentido estricto se denomina clique a 

un conjunto de nodos o actores que tienen todos los vínculos posibles entre 

ellos. Los actores que conforman un clique deben ser más de dos, por lo 

general se trabajan cliques de tres y más integrantes. Un grupo de nodos 

que tienen entre ellos todos los vínculos posibles se denomina “subgrafo 

máximo completo”.  

Pediremos a Ucinet que identifique todos los cliques de más de tres 

integrantes que se encuentran en nuestra red. Para ello, desde la pantalla 

inicial de Ucinet seleccionaremos el menú “Network” y luego 

Subgroups>Cliques:  
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Ilustración 31. Localizando cliques en la red 

 En el cuadro de diálogo que se despliega (que es muy similar a los que 

utilizamos con las medidas de centralidad) seleccionaremos en primer lugar 

la matriz en donde se encuentran los datos que queremos analizar (Imput 

dataset). En este caso es la que hemos estado utilizando hasta ahora 

(estudiantes.##h). La segunda opción es el número mínimo de integrantes 

del clique. La opción por defecto es 3 y en este caso la mantendremos. A 

continuación se nos pregunta si queremos que se analice el patrón de 

superposiciones (Analyze pattern of overlaps). Esto significa que podemos 

saber cuándo un integrante de un clique pertenece a otros, y con cuales 

miembros de la red comparte cliques. Es una información muy interesante, 

que analizaremos con más detalle cuando veamos los resultados. 

Ignoraremos por ahora el resto de las opciones, ya que es necesario que en 

primer lugar aprendamos las cuestiones básicas de esta medida.  

  



 46

 

Ilustración 32. Ventana de diálogo de la opción Cliques 

Al hacer click en “OK” obtenemos las siguiente pantalla:  

 

Ilustración 33. Ventana de datos de los resultados del cálculo de los Cliques 

El primer dato que obtenemos es que se han encontrado 8 cliques en nuestra 

red. Transcribo a continuación los resultados:  

8 cliques found  
1  Andrés- Carmen- Dolors  
2  Andrés- Carmen- Pau  
3  Andrés- Joan- Julio  
4  Andrés- Joan- Pau  
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5  Carlos- Carme- Carol  
6  José- María- Nuria  
7  José María Xavi  
8  Mariano- Martha- Pau  

 

Ningún clique en nuestra red tiene más de tres integrantes. Podemos decir 

que esta red está conformada por pequeñas subestructuras con un alto 

grado de solapamiento (Andrés, por ejemplo, es integrante de la mitad de los 

cliques). Pero el grado de solapamiento se observa con claridad cuando 

analizamos la matriz de superposiciones (que transcribo a continuación):  

Actor-by-Actor Clique Co-Membership Matrix  
  
                               1 1 1 1 1 1 1 1  
             1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7  
             a c c c c d h j j j l m m m n p x  
             - - - - - - - - - - - - - - - - -  
  1  andres  4 0 0 2 0 1 0 2 0 1 0 0 0 0 0 2 0  
  2  carlos  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  3   carme  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  4  carmen  2 0 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0  
  5   carol  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  6  dolors  1 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0  
  7    hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  8    joan  2 0 0 0 0 0 0 2 0 1 0 0 0 0 0 1 0  
  9    jose  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1  
 10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0  
 11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 12   maria  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1  
 13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0  
 14  martha  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0  
 15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 0   
 16     pau  2 0 0 1 0 0 0 1 0 0 0 0 1 1 0 3 0  
 17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 1  

  

A primera vista, esta matriz puede resultar poco clara. Pero vayamos paso 

por paso. La matriz de superposiciones (o de “co-membrecía”) brinda tres 

datos: a cuántos cliques pertenece cada actor, con qué actores comparte 

cliques y cuánto cliques comparte con cada uno de ellos. ¿Cómo debe leerse 

para obtener esta información?  

Para saber a cuántos cliques pertenece cada nodo, leeremos la diagonal de la 

matriz. Así, la información sobre el actor 1 (Andrés) se encuentra en la 
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intersección de la columna 1 y la fila 1, la del actor 2 (Carlos), en la 

intersección de la columna 2 y la fila 2 y así sucesivamente:  

                                   1 1 1 1 1 1 1 1  
             1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7  
             a c c c c d h j j j l m m m n p x  
             - - - - - - - - - - - - - - - - -  
  1  andres  4 0 0 2 0 1 0 2 0 1 0 0 0 0 0 2 0  
  2  carlos  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  3   carme  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  4  carmen  2 0 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0  
  5   carol  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  6  dolors  1 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0  
  7    hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  8    joan  2 0 0 0 0 0 0 2 0 1 0 0 0 0 0 1 0  
  9    jose  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1  
 10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0  
 11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 12   maria  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1  
 13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0  
 14  martha  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0  
 15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 0  
 16     pau  2 0 0 1 0 0 0 1 0 0 0 0 1 1 0 3 0  
 17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 1  

  

Como habíamos visto al analizar los cliques, Andrés pertenece a cuatro 

cliques diferentes, seguido por Pau, que pertenece a tres. La mayoría de los 

actores sólo pertenece a uno, mientras que tenemos dos actores aislados, 

Liliana y Hugo, que no pertenecen a ninguno, ya que, como vimos en el 

análisis de la graficación de la red y en las medidas de centralidad, 

constituyen una díada aislada del resto de la red.  

Para obtener los otros dos datos que presenta esta matriz (con quién se 

comparte clique y qué número de cliques se comparte con cada actor), 

podemos mirar la línea horizontal o la vertical de cada actor:  

                               1 1 1 1 1 1 1 1  
             1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7  
             a c c c c d h j j j l m m m n p x  
             - - - - - - - - - - - - - - - - -  
  1  andres  4 0 0 2 0 1 0 2 0 1 0 0 0 0 0 2 0  
  2  carlos  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  3   carme  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  4  carmen  2 0 0 2 0 1 0 0 0 0 0 0 0 0 0 1 0  
  5   carol  0 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  6  dolors  1 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0  
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  7    hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  8    joan  2 0 0 0 0 0 0 2 0 1 0 0 0 0 0 1 0  
  9    jose  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1  
 10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0  
 11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 12   maria  0 0 0 0 0 0 0 0 2 0 0 2 0 0 1 0 1  
 13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0  
 14  martha  0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 1 0  
 15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 0  
 16     pau  2 0 0 1 0 0 0 1 0 0 0 0 1 1 0 3 0  
 17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 0 0 1  

  

Podemos observar, por ejemplo, que Andrés no comparte ningún clique con 

Carlos o Carme, pero comparte dos cliques con Carmen, Joan y Pau, y uno 

con Dolors y con Julio. O que Dolors comparte un clique con Andrés y otro 

con Carmen, y ninguno más con el resto de los actores de la red, y constatar 

el aislamiento de Liliana y Hugo. Pero también podemos analizar qué 

cliques comparten miembros entre sí. En este caso, nuestra unidad ya no 

son los actores, sino los cliques.  

Clique-by-Clique Co-membership matrix  
  
     1 2 3 4 5 6 7 8  
     - - - - - - - -  
  1  6 2 1 1 0 0 0 0  
  2  2 6 1 2 0 0 0 1  
  3  1 1 6 2 0 0 0 0  
  4  1 2 2 6 0 0 0 1  
  5  0 0 0 0 6 0 0 0  
  6  0 0 0 0 0 6 2 0  
  7  0 0 0 0 0 2 6 0  
  8  0 1 0 1 0 0 0 6  

Esta matriz presenta en las filas y las columnas los cliques y leeremos la 

línea vertical o la horizontal, ignorando la diagonal:  

      1 2 3 4 5 6 7 8  

     - - - - - - - -  

  1  6 2 1 1 0 0 0 0  

  2  2 6 1 2 0 0 0 1  

  3  1 1 6 2 0 0 0 0  

  4  1 2 2 6 0 0 0 1  

  5  0 0 0 0 6 0 0 0  

  6  0 0 0 0 0 6 2 0  

  7  0 0 0 0 0 2 6 0  

  8  0 1 0 1 0 0 0 6  
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Vemos que el clique Nº 1 (integrado por Andrés, Carmen y Dolors) comparte 

dos integrantes con el clique Nº 2 (integrado por Andrés, Carmen y Pau). 

Andrés y Carmen son los dos integrantes que se repiten en ambos cliques. 

El clique Nº 1 también comparte un integrante con el clique Nº 3 y con el Nº 

4 (Andrés es el integrante que se repite en ambos casos).  

A continuación, copiaremos los resultados obtenidos en un documento de 

word, que guardaremos con el nombre de “informe practica 2”):  

 

Ilustración 34. Guardando los resultados en Word 

 N-CLIQUE, N-CLAN Y K-PLEX  

Como señala Hanneman (op. cit) en algunas ocasiones, la definición “dura” 

de clique (sub-grafo máximo completamente conectado) es demasiado 

estricta para nuestros fines. Puede interesarnos conocer cliques en los que 

algunos de sus miembros no estén conectados con todos los demás 

integrantes, por ejemplo. Existen una serie de medidas de agrupación que 

relajan la condición de subgrafo máximo completo: N-clique, N-clan y k-plex, 

que revisaremos a continuación.  
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Según la primera medida, N-clique, un actor es miembro de un clique si está 

conectado con todos los miembros del grupo a una distancia mayor que uno. 

Generalmente se utiliza una distancia de dos (lo que equivale a ser amigo de 

un amigo).  

Aplicaremos N-clique a nuestros datos. Para ellos, seleccionaremos el menú 

Network y a continuación Subgroups>N-cliques. 

En el cuadro de diálogo que se despliega, seleccionaremos en primer lugar la 

matriz que contiene los datos a analizar (estudiantes.##h). La segunda 

opción nos indica el tamaño de la n (la distancia que estableceremos). 

Mantendremos la opción por defecto, que es 2. La tercera opción es el 

tamaño mínimo de los cliques que identificaremos (mantedremos 3) y la 

cuarta nos pregunta si queremos obtener la matriz de superposiciones o co-

membrecía (selecionaremos “yes”). Como en el caso del análisis de cliques, 

ignoraremos ahora el resto de las posibilidades.  

   

Ilustración 35. Ventana de diálogo de N-Cliques 

Obtenemos el siguiente resultado:  



 52

 

Ilustración 36. Resultados de N-Cliques 

La primera diferencia en relación con el análisis anterior es que hemos 

obtenido tres cliques menos (ahora son cinco) pero de mayor tamaño. En 

efecto, la condición “conozco a alguien que lo conoce” nos devuelve grupos 

más grandes. Reproduzco a continuación los resultados de la primera 

matriz:  

5 2-cliques found.  
1  andres carmen dolors joan jose julio pau  
2  dolors joan jose maria nuria xavi  
3  andres carlos carmen dolors joan julio pau  

4  andres carmen joan mariano martha pau  
5  andres carlos carme carol  

 

Se han identificado dos cliques con siete miembros, dos con seis y uno con 

cuatro. N-clique es una medida mucho más inclusiva que clique. Por esta 

razón es importante ser cuidadosos a la hora de utilizarla, ya que podrían 

incluirse dentro de un mismo grupo actores que realmente no tienen una 

pertenencia clara.  
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En lo que hace a los actores que integran cada grupo, vemos que Andrés 

continua teniendo un protagonismo importante (integra cuatro de los cinco 

cliques). Pero aparece una modificación: ya no es el único actor destacado, 

sino que tenemos a otro actor (Joan) integrando también cuatro cliques. 

Joan ha doblado su participación respecto de la medición anterior. Y este 

caso es un buen ejemplo para graficar la diferencia entre clique y N-clique. 

De acuerdo con las medidas de centralidad que hemos calculado 

anteriormente, Joan tiene un rango de 4, es decir, conoce a cuatro personas 

en la red: Andrés, Julio, Pau y José. Cuando calculamos los cliques, vimos 

que, de acuerdo con los datos de la tabla 6, Joan forma un clique junto con 

Andrés y Julio y otro con Andrés y Pau. No integra ningún clique con José, 

que es la cuarta persona que conoce en la red, ya que no tiene relación con el 

resto de los integrantes de estos cliques (José forma un clique con María y 

Nuria y otro con María y Xavi). Pero al aligerar la condición de la relación, a 

través de N=2, tenemos que pertenece al clique Nº 1 porque conoce 

directamente a Andrés, Julio, José y Pau, e indirectamente a Carmen (a 

través de Andrés o de Pau) y a Dolors (a través de José o de Andrés). En el 

clique Nº 2 sólo conoce directamente a José, pero “hereda” sus relaciones con 

María, Nuria y Xavi, y llega nuevamente a Dolors a través de Andrés o de 

Pau (aunque ellos no integren el clique. Retomaremos este punto en el 

análisis de N-clan). El mismo proceso sucede en los cliques Nº 3 y 4.  

Veamos ahora la matriz de solapamientos o co-membrecía. Leeremos la 

diagonal en primer lugar:  

  
                               1 1 1 1 1 1 1 1  
             1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7  
             a c c c c d h j j j l m m m n p x  
             - - - - - - - - - - - - - - - - -  
  1  andres  4 2 1 3 1 2 0 3 1 2 0 0 1 1 0 3 0  
  2  carlos  2 2 1 1 1 1 0 1 0 1 0 0 0 0 0 1 0  
  3   carme  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  4  carmen  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0  
  5   carol  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  6  dolors  2 1 0 2 0 3 0 3 2 2 0 1 0 0 1 2 1  
  7    hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  8    joan  3 1 0 3 0 3 0 4 2 2 0 1 1 1 1 3 1  
  9    jose  1 0 0 1 0 2 0 2 2 1 0 1 0 0 1 1 1  
 10   julio  2 1 0 2 0 2 0 2 1 2 0 0 0 0 0 2 0  
 11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
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 12   maria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1  
 13 mariano  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0  
 14  martha  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0  
 15   nuria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1  
 16     pau  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0  
 17    xavi  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1  

  

Tenemos dos actores pertenecientes a cuatro cliques cada uno, tres a tres 

cliques, tres a dos  y siete a uno. Ha aumentado el número de cliques de 

partencia, pero al igual que en eser caso, Liliana y Hugo están aislados del 

resto de la red. Respecto de la co-participación (leyendo la línea vertical u 

horizontal) vemos lo siguiente:  

                               1 1 1 1 1 1 1 1  
             1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7  
             a c c c c d h j j j l m m m n p x  
             - - - - - - - - - - - - - - - - -  
  1  andres  4 2 1 3 1 2 0 3 1 2 0 0 1 1 0 3 0  
  2  carlos  2 2 1 1 1 1 0 1 0 1 0 0 0 0 0 1 0  
  3   carme  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  4  carmen  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0  
  5   carol  1 1 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0  
  6  dolors  2 1 0 2 0 3 0 3 2 2 0 1 0 0 1 2 1  
  7    hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  8    joan  3 1 0 3 0 3 0 4 2 2 0 1 1 1 1 3 1  
  9    jose  1 0 0 1 0 2 0 2 2 1 0 1 0 0 1 1 1  
 10   julio  2 1 0 2 0 2 0 2 1 2 0 0 0 0 0 2 0  
 11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 12   maria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1  
 13 mariano  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0  
 14  martha  1 0 0 1 0 0 0 1 0 0 0 0 1 1 0 1 0  
 15   nuria  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1  
 16     pau  3 1 0 3 0 2 0 3 1 2 0 0 1 1 0 3 0  
 17    xavi  0 0 0 0 0 1 0 1 1 0 0 1 0 0 1 0 1  

  

Ha aumentado el número de actores con los que se comparte clique. Esto se 

debe a la mayor inclusividad que tiene N-clique en relación con clique. Si 

vemos los resultados obtenidos ahora por los dos actores que tomamos como 

ejemplo a la hora de analizar la co-membrecía en la tabla 9, Andrés y 

Dolors, vemos que en ambos casos ha aumentado el número de personas con 

los que comparten clique: Andrés pasa de 5 a 11 y Dolors de 2 a 11. Y 

además aumenta el número de participaciones compartidas con cada actor.  

Una manera de restringir N-clique es utilizando N-clan. Como hemos 

mencionado, en ocasiones al aplicar N-clique se muestra conectividad a 
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través de actores que no son miembros del clique (el caso de la relación entre 

Dolors y Joan, en el clique 2, mediada por actor que no formaba parte de ese 

clique). Si en cambio utilizamos N-clan, introducimos una cláusula en el 

análisis: la relación continúa siendo mediada (accedo a alguien porque es 

conoce a una persona que yo conozco) pero todos los vínculos deben 

alcanzarse mediante otros miembros del clique.  

Veamos lo que sucede con nuestros datos cuando aplicamos N-clan. El 

procedimiento es similar al resto de las medidas de agrupamiento: (Menú 

Network>Subgroups>N-clan). 

El cuadro de diálogo es como los que habíamos utilizado anteriormente: 

seleccionamos la matriz que contiene los datos; determinamos el valor de N 

(que este caso será 2, al igual que en N-clique); pedimos cliques de tres o 

más integrantes y analizaremos el patrón de superposiciones.  

 

Ilustración 37. Ventana de diálogo de N-Clan 

 Obtenemos la siguiente pantalla de resultados:  
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Ilustración 38. Resultados N-Cliques 

Los resultados son muy similares a los obtenidos mediante N-clique: cinco 

cliques. Veamos su composición:  

5 2-clans found.  

1  andres carmen dolors joan jose julio pau  
2  dolors joan jose maria nuria xavi  
3  andres carlos carmen dolors joan julio pau  
4  andres carmen joan mariano martha pau  
5  andres carlos carme carol  

 

Aunque la composición es idéntica al caso de N-clique (ya que la definición 

de N-clique se encuentra incluida en la de N-clan), el procedimiento es 

diferente Veamos el ejemplo de Andrés. Pertenece al clan Nº 5 por su 

relación con Carlos, ya que no conoce directamente a Carme o a Carol. Pero 

no podría invocar a ningún otro actor para pertenecer al clan si este no 

perteneciera también. N-clan es un modificación menor de N-clique, y como 

hemos observado en el ejemplo, en muchos casos se obtienen idénticos 

resultados, pero ambas medidas se complementan, ya que permiten 
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asegurarnos de que los actores que incluimos en un clique realmente 

pertenecen a él.  

La última medida que analizaremos es K-plex. Su definición es muy 

sencilla: un actor puede ser miembro de un clique siempre y cuando tenga 

vínculos directos con todos excepto K miembros del grupo.  

Hanneman dice que, si bien  

(…) el enfoque K-plex parece tener bastante en común con el N-clique, el 

análisis basado en K-plex a menudo arroja un cuadro bastante diferente de 

las sub-estructuras del grafo. En vez de las agrupaciones grandes y 

concatenadas que a veces produce el análisis N-clique, el análisis K-plex 

tiende a encontrar número relativamente grandes de pequeñas agrupaciones. 

Esto tiende a llamar la atención sobre yuxtaposiciones y co-presencia 

(centralización) más que en solidaridad y accesibilidad. (cap- V: p. 11)  

K-plex, entonces, muestra infoormación sobre círculos sociales superpuestos. 

Veamos qué sucede cuando aplicamos K-plex a nuestros datos. Daremos a K 

el valor de 2 (un actor será miembro de un clique si conoce a todos menos 

dos actores del mismo). Seleccionamos el menú Network>Subgroups>K-

plex. El cuadro de diálogo es similar a todos los anteriores. Seleccionamos 

el documento a analizar, determinamos el valor de K (2), declaramos que los 

grupos deben tener 3 o más integrantes y pedimos la matriz de 

superposiciones:  

 

Ilustración 39. Ventana de diálogo de K-plex 
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Obtenemos el siguiente resultado:  

 

Ilustración 40. Resultados de K-Plex 

Nuestra red consta de 31 K-plex, es decir 31 subgrupos en donde un actor 

conoce a todos los integrantes menos a dos. Transcribo los resultados de la 

primera tabla:  

31 k-plexes found.  

1  andres carlos carme  

2  andres carlos carmen  

3  andres carlos carol  

4  andres carlos dolors  

5  andres carlos joan  

6  andres carlos julio  

7  andres carlos pau  

8  andres carmen dolors pau  

9  andres carmen joan pau  

10  andres carmen julio  

11  andres dolors joan jose  

12  andres dolors julio  
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13  andres joan julio pau  

14  andres mariano pau  

15  andres martha pau  

16  carlos carme carol  

17  carmen dolors jose  

18  carmen mariano pau  

19  carmen martha pau  

20  dolors jose maria  

21  dolors jose nuria  

22  dolors jose xavi  

23  joan jose julio  

24  joan jose maria  

25  joan jose nuria  

26  joan jose pau  

27  joan jose xavi  

28  joan mariano pau  

29  joan martha pau  

30  jose maria nuria xavi  

31  mariano martha pau  

 
  

Vemos una gran mayoría de K-plexes de tres integrantes (26) y sólo cinco 

con más de tres. Andrés es el actor que se repite mayor cantidad de veces, 

como podemos comprobar al mirar la matriz de superposiciones: está 

presente en 15 grupos. Pero también hay otros actores con participaciones 

importantes. Al utilizar esta medida, todos los actores aumentan el número 

de cliques a los que perteneces.  

              1  2  3  4  5  6  7  8  9 10 11 12 13 14 15 16 17  
             an ca ca ca ca do hu jo jo ju li ma ma ma nu pa xa  
             -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --  
  1  andres  15  7  1  4  1  4  0  4  1  4  0  0  1  1  0  6  0  
  2  carlos   7  8  2  1  2  1  0  1  0  1  0  0  0  0  0  1  0  
  3   carme   1  2  2  0  1  0  0  0  0  0  0  0  0  0  0  0  0  
  4  carmen   4  1  0  7  0  2  0  1  1  1  0  0  1  1  0  4  0  
  5   carol   1  2  1  0  2  0  0  0  0  0  0  0  0  0  0  0  0  
  6  dolors   4  1  0  2  0  8  0  1  5  1  0  1  0  0  1  1  1  
  7    hugo   0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  
  8    joan   4  1  0  1  0  1  0 11  6  2  0  1  1  1  1  5  1  
  9    jose   1  0  0  1  0  5  0  6 11  1  0  3  0  0  3  1  3  
 10   julio   4  1  0  1  0  1  0  2  1  5  0  0  0  0  0  1  0  
 11 liliana   0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  
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 12   maria   0  0  0  0  0  1  0  1  3  0  0  3  0  0  1  0  1  
 13 mariano   1  0  0  1  0  0  0  1  0  0  0  0  4  1  0  4  0  
 14  martha   1  0  0  1  0  0  0  1  0  0  0  0  1  4  0  4  0  
 15   nuria   0  0  0  0  0  1  0  1  3  0  0  1  0  0  3  0  1  
 16     pau   6  1  0  4  0  1  0  5  1  1  0  0  4  4  0 12  0  
 17    xavi   0  0  0  0  0  1  0  1  3  0  0  1  0  0  1  0  3  

  

Algo similar observamos al analizar la línea horizontal (o vertical):  

              1  2  3  4  5  6  7  8  9 10 11 12 13 14 15 16 17  

             an ca ca ca ca do hu jo jo ju li ma ma ma nu pa xa  

             -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --  

  1  andres  15  7  1  4  1  4  0  4  1  4  0  0  1  1  0  6  0  

  2  carlos   7  8  2  1  2  1  0  1  0  1  0  0  0  0  0  1  0  

  3   carme   1  2  2  0  1  0  0  0  0  0  0  0  0  0  0  0  0  

  4  carmen   4  1  0  7  0  2  0  1  1  1  0  0  1  1  0  4  0  

  5   carol   1  2  1  0  2  0  0  0  0  0  0  0  0  0  0  0  0  

  6  dolors   4  1  0  2  0  8  0  1  5  1  0  1  0  0  1  1  1  

  7    hugo   0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  

  8    joan   4  1  0  1  0  1  0 11  6  2  0  1  1  1  1  5  1  

  9    jose   1  0  0  1  0  5  0  6 11  1  0  3  0  0  3  1  3  

 10   julio   4  1  0  1  0  1  0  2  1  5  0  0  0  0  0  1  0  

 11 liliana   0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  0  

 12   maria   0  0  0  0  0  1  0  1  3  0  0  3  0  0  1  0  1  

 13 mariano   1  0  0  1  0  0  0  1  0  0  0  0  4  1  0  4  0  

 14  martha   1  0  0  1  0  0  0  1  0  0  0  0  1  4  0  4  0  

 15   nuria   0  0  0  0  0  1  0  1  3  0  0  1  0  0  3  0  1  

 16     pau   6  1  0  4  0  1  0  5  1  1  0  0  4  4  0 12  0  

 17    xavi   0  0  0  0  0  1  0  1  3  0  0  1  0  0  1  0  3  

 

Aumenta el número de cliques que se comparten con el resto de integrantes 

de la red. Pero, siguiendo a Hanneman, eliminaremos los cliques de sólo tres 

integrantes, ya que nos dan poca información adicional (sólo hace falta 

conocer a un miembro para formar parte del grupo). Repetiremos el 

procedimiento, pero esta vez declararemos que el tamaño mínimo del grupo 

deberá ser de 4 nodos. Trancribo a continuación los resultados obtenidos:  

1  andres carmen dolors pau  
2  andres carmen joan pau  
3  andres dolors joan jose  
4  andres joan julio pau  
5  jose maria nuria xavi  

 

 Sólo existen cinco sub.grupos que cumplan con las características 

solicitadas. Y una vez más Andrés es el actor más destacado, con cuatro 
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participaciones. Pero también lo son Joan y Pau, con tres participaciones 

cada uno.   

                              1 1 1 1 1 1 1 1  
             1 2 3 4 5 6 7 8 9 0 1 2 3 4 5 6 7  
             a c c c c d h j j j l m m m n p x  
             - - - - - - - - - - - - - - - - -  
  1  andres  4 0 0 2 0 2 0 3 1 1 0 0 0 0 0 3 0  
  2  carlos  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  3   carme  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  4  carmen  2 0 0 2 0 1 0 1 0 0 0 0 0 0 0 2 0  
  5   carol  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  6  dolors  2 0 0 1 0 2 0 1 1 0 0 0 0 0 0 1 0  
  7    hugo  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
  8    joan  3 0 0 1 0 1 0 3 1 1 0 0 0 0 0 2 0  
  9    jose  1 0 0 0 0 1 0 1 2 0 0 1 0 0 1 0 1  
 10   julio  1 0 0 0 0 0 0 1 0 1 0 0 0 0 0 1 0  
 11 liliana  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 12   maria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 1  
 13 mariano  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 14  martha  0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0  
 15   nuria  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 1  
 16     pau  3 0 0 2 0 1 0 2 0 1 0 0 0 0 0 3 0  
 17    xavi  0 0 0 0 0 0 0 0 1 0 0 1 0 0 1 0 1  

  

K-plex presenta grupos más “legítimos” en cierto sentido, ya que elimina la 

presencia de los intermediarios (tengo que conocer directamente a todos los 

miembros menos a dos, en este caso).  

Al igual que en el caso de las medidas de centralidad, las medidas de 

agrupamiento son complementarias, y la combinación de ellas nos devuelve 

una imagen más ajustada de la estructura de la red.  

Para terminar con este ejercicio, pegaremos los resultados obtenidos en el 

documento de Word.  
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EL ANÁLISIS DE REDES PERSONALES CON 

EGONET Y VISUALIZER5 

Existen dos perspectivas diferentes para el estudio de las redes sociales: la 

sociocéntrica y la egocéntrica. La perspectiva sociocéntrica suele identificar 

para cada contexto institucional una red diferente. Así, si utilizamos como 

generador de nombres, “señala por favor a quiénes elegirías como 

representantes de esta lista”, o “dime a quién pedirías prestado dinero”, la 

red de respondientes y personas nominadas será diferente en cada caso. 

Naturalmente, podemos recoger diferentes contextos y combinarlos, pero la 

perspectiva sigue siendo la misma: un conjunto definido de personas o 

actores que tienen relaciones entre sí por algún tipo de relación (o contexto 

institucional) previamente definido.  

La perspectiva egocéntrica, en cambio, parte de un ego o punto focal y se 

interroga por todas las relaciones existentes. Naturalmente, de esta forma 

se recogen (o se deberían recoger) todos los contextos institucionales en los 

que se mueve ego, es decir, familia, vecinos, compañeros de estudio o 

trabajo, grupo religioso o cualquier institución relevante para su vida social. 

Estas instituciones varían según la cultura, naturalmente.  

Ahora bien, ¿cómo recoger o aproximarse la miríada de interacciones que se 

producen alrededor de una persona? La respuesta a esta pregunta depende 

también de la perspectiva adoptada. En general podemos afirmar que las 

redes personales están constituidas por un centro de lazos fuertes que 

cambia lentamente a lo largo de la vida y una periferia más amplia y 

dinámica. El tamaño de esta red varía enormemente en la escala social, de 

forma que las personas con cargos políticos o administrativos de importancia 

suelen tener unas redes muy amplias comparadas con las redes de personas 

marginales en una sociedad. Si atendemos a las relaciones acumuladas a lo 

largo de una vida (muchas de ellas se olvidan) el resultado es de 3500 

                                            

5 Autor: José Luis Molina (Departament d’Antropologia social i cultural, UAB). 
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personas (Cf. Molina, 2005 para una explicación detallada de los métodos). 

Si atendemos a las relaciones estables, podemos identificar una media de 

unas 300 personas, con una desviación típica importante en función de la 

clase social y el sexo. Si atendemos a las relaciones fuertes e íntimas, el 

número se puede reducir a menos de una veintena. En el siguiente gráfico 

podemos apreciar estas diferencias. 
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Ilustración 41. Las diferentes estimaciones del tamaño de la red personal 

Christopher McCarty (2002) sugiere un cambio en el enfoque del estudio de 

redes personales, pasando de la estimación del tamaño a la estimación de la 

estructura de las redes personales. La pregunta es: ¿cuál es el mínimo de 

número de alteri sobre los que hay que indagar para disponer de una idea 

aproximada de la estructura de la red personal? McCarty propone que un 

número entre 30 y 45  personas tiene que ser suficiente si el generador de 

nombres utilizado permite obtener una lista libre de personas de todas las 

categorías sociales. Por ejemplo:  
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Por favor, díganos una lista de 40 personas que Ud. conozca. Intente 

que todas las categorías importantes de personas (parientes, amigos, 

compañeros, vecinos...) estén representados en la lista. 

El generador utilizado tiende a producir lazos íntimos al principio, pero la 

lista es lo suficientemente larga como para recoger información de diferentes 

áreas de la estructura de las redes personales, incluidos los lazos débiles. A 

continuación es necesario indagar sobre quién conoce a quién, aparte de 

recoger datos atributivos sobre ego y los alteri. Esta parte es la más larga 

pues una lista de 40 personas implica 780 preguntas de si dos personas se 

conocen o tienen algún tipo de relación que interese recoger. Para obtener 

esta información es necesaria la ayuda del programa Egonet. Por último, se 

presenta un informe a ego sobre su propia red personal. En todos los casos, 

los informantes se han mostrado sorprendidos por la calidad de la 

información mostrada sobre sus propias redes.  

El estudio de las redes personales tiene la inmensa ventaja que permite 

aplicar los métodos de muestreo de poblaciones (a diferencia del enfoque 

sociocéntrico) y que los resultados acerca de la composición y la estructura 

de cada red personal pueden ser convertidos en variables atributivas de los 

casos y formar parte de los modelos explicativos sobre una variedad de 

temas (salud, discursos, rendimiento académico, aculturación …). 

En este ejercicio realizaremos tres actividades. La primera, con el módulo de 

administración de Egonet, diseñaremos un cuestionario que nos permita 

aproximarnos a nuestra propia red personal. La segunda actividad 

consistirá en recoger datos de nuestra red personal (y, en su caso, la de otras 

personas) y visualizarla y analizarla con Visualizer, el módulo de 

visualización incorporado en Egonet. La tercera actividad consistirá en 

exportar los datos recogidos a SPSS.  

NOTAS SOBRE LA INSTALACIÓN DE EGONET  
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MÓDULO ADMINISTRADOR (EGONET_QB) 

El módulo Administrador de Egonet se llama Egonet_ QB (Egonet Q- 

Builder, administrador de cuestionarios). Una vez clicamos el icono aparece 

la siguiente pantalla: 

 

Ilustración 42. Pantalla de identificación de Egonet_QB 

Introduciremos, en la versión de prueba, la misma serie de caracteres: nimh 

y clicaremos Ok. La pantalla que obtendremos será la siguiente: 
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Ilustración 43. Pantalla de QBuilder 

A continuación Seleccionaremos File>New Study y, en la parte derecha de 

la pantalla, escribiremos “Red personal” en el campo Study Name y 

fijaremos en 30 el número de nominados o alteri (“Nominees”). 
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Ilustración 44. Módulos de QBuilder 

Los módulos que componen QBuilder son “Questions about Ego”, las 

variables identificativas de Ego, “Name Generador(s)”, la pregunta o 

preguntas que utilizaremos para generador nombres o nominaciones de 

personas, “Questions about Alters”, las variables que pediremos para cada 

una de las personas nominadas y “Alter tie evaluation”, la pregunta que 

utilizaremos para saber si dos personas nominadas tienen algún tipo de 

relación entre sí.  

QUESTIONS ABOUT EGO 

Si seleccionamos la primera opción, “Questions about Ego” obtendremos una 

pantalla que nos permitirá introducir una información estática que 

permanecerá en la pantalla del usuario durante toda la fase de recogida de 

variables atributivas de Ego. Esta información (totalmente opcional) puede 

aparecer tanto en la parte superior como en la parte inferior de la pantalla. 

Introduciremos el rótulo “En este apartado le pediremos alguna información 

sobre Ud.” Para la cabecera y “Estudio de la red personal” en el pie de la 

siguiente forma: 
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Ilustración 45. Pantalla de entrada al módulo de preguntas sobre Ego 

Ya estamos en condiciones de crear preguntas para cada Ego. La 

información Ego ID, Nombre y Apellido aparece automáticamente cuando se 

ejecuta Egonet, por lo que no es necesario introducir estas preguntas. 

Clicaremos el botón Create New Item e introduciremos la primera 

pregunta, la edad de Ego. 
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Ilustración 46. Variable atributiva de Ego 

Observamos que en el campo Text se introduce el literal de la pregunta, en 

el campo Variable name, una cadena de un máximo de 5 caracteres (en 

este caso solamente hemos utilizado 4: edad) y en Answer Type hemos 

seleccionado “Numeric” para poder introducir directamente los años como 

un número entero. Siempre estaremos a tiempo después de convertir la edad 

en categorías en SPSS.  

Si clicamos el botón Create New Ego Item podremos introducir una nueva 

variable, el sexo en este caso. Para ello introducimos un literal (“¿Es Ud. 

hombre o mujer?), el nombre de la variable (“sexo”) y seleccionamos el botón 

Selections (si en Answer type figura la opción “Categorical”). Al hacerlo 

se nos abre una ventana de gestión de categorías. Obsérvese que una vez 

creado un conjunto de categorías para una respuesta resta disponible para 

los nuevos estudios. En este caso utilizaremos la categoría disponible 

Sex_esp, que es la que nos interesa y clicaremos el botón Select.  
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Ilustración 47. Gestor de categorías 

En el caso de no disponer de las categorías adecuadas podemos crear una 

nueva de la siguiente forma: clicando Add (botón izquierdo de la pantalla), 

introduciendo “sexo” en el espacio superior derecho (“Current selected 

category:”), clicando Add (botón derecho de la pantalla), introduciendo 

“Hombre”, “1”, “1” y clicando otraz vez Add e introduciendo “Mujer”, “2”, “2” 

y clicando Select. La columna “Score” nos indica el valor que se introducirá 

en la celda SPSS, mientras que el valor “Sequence” nos indica el número de 

orden en la ventana de selección de categorías.  

Podemos así ir introduciendo las categorías que estimados de interés para 

nuestra investigación. Para borrar una variable, simplemente nos colocamos 

en el panel izquierdo, seleccionamos la variable y clicamos el botón derecho 

del ratón para obtener la opción de borrar.  

NAME GENEARATOR(S) 

En el siguiente módulo de QBuilder disponemos de nuevo de la opción de 

informar al usuario en la cabecera y el pié de la pantalla. En este caso 

dejaremos en blanco los campos, clicaremos el botón Create New Item e 

introduciremos “Lista libre nombres” en el campo Title y la expresión 

“Díganos nombres de personas que conozca por su nombre de pila y 
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viceversa y con las que haya tenido al menos algún contacto personal en los 

dos últimos años y con la que sea posible contactar de nuevo si fuese 

necesario. Intente que todas las categorías de contactos estén 

representados”. Seleccionaremos a continuación “First Name Only” en el 

campo Format (siempre es útil trabajar con acrónimos, por ejemplo MigCer 

para Miguel de Cervantes) y clicaremos el botón Create new name 

generador Item.  

QUESTIONS ABOUT ALTERS 

En este módulo introduciremos variables atributivas del mismo modo que el 

módulo para Ego. En este caso introduciremos también la edad, el sexo y la 

categoría ocupacional. Otras variables, como la nacionalidad o  la ciudad de 

residencia habitual, exigirían bien un listado de países adaptado a los 

respondientes, bien un espacio en blanco para la introducción de un literal. 

Es importante limitar el número de variables de este módulo, pues cada 

variable tendrá que ser contestada 30 veces (una vez por cada alter o 

persona nominada).  

Crearemos las siguientes preguntas (Egonet sustituye automáticamente $$ 

por el nombre de cada alter): 

 “¿La edad aproximada de $$ es …?” (numérica), nombre de la variable 

edada. 

 “¿El sexo de $$ es …? (categórica, sex_esp), nombre de la variable 

sexoa. 

 “¿La categoría ocupacional de $$ es, de una escala de 0 a 5 (0 

dependiente, trabajador/a doméstico … a 5, directivo/a, responsable 

político de alto nivel) es …”? (numérica), nombre de la variable 

cat_o.  

Si hemos realizado correctamente estas operaciones, el aspecto de QBuilder 

debería ser el siguiente: 
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Ilustración 48. Construcción del cuestionario con QBuilder 

Y ahora nos resta el módulo final.  

ALTER TIE EVALUATION 

En este módulo introduciremos una sola pregunta para relacionar los alteri 

entre sí. Esta pregunta es la siguiente: 

 “¿$$ y $$ se relacionarían entre sí Ud no estuviese?” (categórica, “Muy 

probablemente (2), probablemente (1), no es probable (0)”), nombre de 

la variable: relac. 

Una vez completado el cuestionario guardaremos el estudio (File>Save 

all) aceptando la ventana de diálogo.  

Con esto ya tenemos creado un estudio en la base de datos 

Psychometrica.gdb. En esta base de datos podemos ir añadiendo otros 

estudios. Para ello simplemente tenemos que clicar un estudio existente (por 

ejemplo el que acabamos de crear llamado “Red personal”) y pulsando el 

botón derecho del ratón podemos seleccionar la opción Duplicate y utilizar 

ese estudio como punto de partida para realizar las modificaciones que 
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estimemos oportunas. También podemos archivar el estudio (opción 

Archive), para que no aparezca en la pantalla principal. Si queremos 

recuperar los estudios archivados solamente tenemos que seleccionar del 

menú Tools la opción Study Archive, opción que nos permitirá activar o 

archivar los estudios almacenados en la base de datos.  

Con File>Exit saldremos del módulo de administración de Egonet con 

nuestro cuestionario listo para ser utilizado.  

MÓDULO CLIENTE (EGONET) 

La pantalla de identificación que obtenemos cuando ejecutamos Egonet es la 

siguiente: 

 

Ilustración 49. Pantalla de identificación de Egonet (módulo cliente) 

Una vez introducida la palabra clave (nimh si se trata de la versión de 

prueba)  y aceptando, obtenemos una pantalla informativa de los estudios 

disponibles. En este caso disponemos del estudio “Red personal” pero 

podríamos seleccionar uno de una lista de estudios disponibles. Si clicamos 

el botón Next obtenemos la siguiente pantalla: 
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Ilustración 50. Opciones de entrevista con Egonet 

Egonet está diseñado para recoger cientos de entrevistas a partir de un 

estudio o cuestionario. Por ello es posible iniciar una nueva entrevista 

(“Start Interview”), dejar una entrevista a medias y continuar (“Continue 

Incomplete Interview”), Visualizar una entrevista completa (“View 

Completed Interview”) o Borrar una entrevista (“Delete Interview”).  

Si volvemos a clicar el botón Next obtenemos la siguiente pantalla: 
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Ilustración 51. Identificación de Ego 

Es recomendable introducir un código único para cada Ego, por ejemplo, 

1001, 1002, etc. El nombre y el apellido pueden ser auténticos, pero siempre 

es recomendable la utilización de acrónimos. Introducimos, por ejemplo, 

“1001”, “Juan” y “Ruiz” en cada uno de los tres campos respectivos y 

continuamos.  

Una vez hemos clicado el botón Start nos aparece la primera pantalla que 

hemos diseñado previamente, con su cabecera y pie informativos 

correspondiente al primer módulo de preguntas sobre Ego.  
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Ilustración 52. Primera pantalla diseñada previamente con QBuilder 

Una vez contestadas las preguntas nos aparece la pantalla correspondiente 

al segundo módulo. En todo momento disponemos de una barra informativa 

sobre el porcentaje de trabajo de cada módulo que nos resta por cumplir. 

Una vez introducido el nombre o el acrónimo debemos aceptar con un 

Return o Enter.  
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Ilustración 53. Lista de nominados 

 

Ahora viene la parte más larga de la entrevista, la atribución de variables a 

los alteri.  

Una vez cumplimentada esta parte nos aparece el último módulo de 

relación, indicando cada pareja de nominados: 

 

Ilustración 54. Módulo cuarto para la relación entre las personas nominadas 
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Se observará que es posible clicar la opción adecuada o bien teclear el 

número, lo cual suele ser más rápido.  

Una vez completado este módulo, el ordenador calcula el gráfico resultante 

y, después de unos minutos, nos avisa que se han seleccionado todas las 

relaciones probables.  Seleccionamos la opción de “Muy probablemente” y 

observamos la red personal resultante.  

 

Ilustración 55. Visualización de la red personal 

El módulo de visualización nos permite analizar la red personal. Un ejemplo 

de análisis de la red personal mediante combinación de las diferentes 

variables recogidas se ofrece en el apartado siguiente.  

LA ENTREVISTA CUALITATIVA CON VISUALIZER 

La visualización de la red personal es un recurso extraordinario para 

indagar conjuntamente con el informante acerca del significado de los 

diferentes grupos, posición de personas o distribución de variables de su red 

personal. En este apartado mostramos un ejemplo tomado de un proyecto de 
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investigación que ilustra las posibilidades que ofrece el módulo de 

visualización de Egonet. Estas entrevistas pueden grabarse utilizando el 

mismo ordenador con programas gratuitos con Windows Media Encoder, por 

ejemplo.  

En este caso se ha escogido como en nuestro ejemplo anterior la opción “Muy 

probablemente” (Very likely) y clicando sobre el botón Spring Embedding 

Layout, el quinto por la izquierda). El resultado es el siguiente: 

 

Ilustración 56. Ejemplo de red personal 

A continuación vamos a realizar un conjunto de manipulaciones en la 

visualización que nos permitan introducir un conjunto de variables visuales 

en la red personal sobre la estructura y composición de su red.  

Clicando directamente en cada nodo se puede acceder a toda la información 

introducida sobre el nodo. Así si clicamos encima de Pam tenemos: 
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Ilustración 57. Variables atributivas de un alter 

Es decir, las variables en la izquierda y su contenido en la derecha de la 

tabla.  

CLUSTERS O GRUPOS DE LA RED PERSONAL 

En primer lugar pediremos al informante que nos explique la estructura 

global de su red. Para esto nos ayudará la función Analysis>Partitions-
Clusters>Hierarchical Clustering 
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Ilustración 58. Buscando grupos en la red personal 

El resultado es el siguiente: 
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Ilustración 59. Clusters de la red personal numerados 

La pantalla con los resultados hay que moverla para poder enseñar los 

grupos y preguntar por su significado. Cuando hayamos acabado 

simplemente hay que cerrar la pantalla de datos. Clicando en cualquier 

punto de la pantalla se vuelve a la situación original.  

GRADO DE INTERMEDIACIÓN 

Vamos a representar en la visualización el grado de intermediación de los 

nodos con un color. Para ello haremos lo siguiente: Analysis>Node 

Centrality. Aparece entonces la siguiente ventana y seleccionaremos los 

cuadros de color y la betweeness centrality: 

 

Ilustración 60. Coloreando la red personal en función del grado de 

intermediación 
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Aceptamos y obtenemos lo siguiente: 

 

Ilustración 61. Red personal que muestra grupos y grado de intermediación 

Ahora podemos preguntar sobre los nodos con el tono de color más acusado y 

también sobre el resto, por supuesto. 

COMPOSICIÓN: SEXO, RESIDENCIA Y OTRAS 

A continuación vamos a mostrar dos variables visuales al mismo tiempo 

(color y forma, además de la posición) a partir de las variables disponibles 
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sobre la composición de la red personal. De entrada haremos las siguientes 

selecciones: 

• Color: residencia actual.  

• Forma: sexo (triángulo hombres, círculo mujeres) 

Por supuesto se pueden explorar otras variables, las que sean necesarias en 

función de los objetivos del estudio.  

Seleccionamos en primer lugar “Shape by attribute”. 

 

Ilustración 62. Red personal con grupos, color a la que se quiere añadir la forma 

en función de una variable 

 



 85

 

Elegimos la variable Asex en este caso y seleccionamos las formas 

adecuadas en Select, seleccionando antes la categoría a cambiar: 

 

Ilustración 63. Añadiendo la forma en función de la variable sexo 
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Hacemos lo mismo con la segunda, clicamos en el botón Apply y obtenemos 

lo siguiente: 

 

A continuación seleccionamos el color, y la variable Aliv, que en este caso 

significa dónde viven actualmente: 
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Ilustración 64. Red personal con indicación de los grupos, el sexo y la residencia 

de los alteri 

En este caso, la mayor parte de la red vive en los Estados Unidos.  
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En función de la información que obtengamos podemos ir mostrando nuevas 

variables visuales en la pantalla. Para ello es útil clicar la opción 

Windows>Show Study Questions. Así, en el apartado Questions About 

Alters es posible elegir la variable más adecuada: 

 

Ilustración 65. Funcionalidad que permite ver las preguntas del cuestionario al 

mismo tiempo que la visualización 

Los ejemplos pueden multiplicarse. El siguiente paso será exportar a SPSS 

todas las entrevistas realizadas con sus correspondientes variables.  
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EL ANÁLISIS DINÁMICO DE REDES CON SIENA6-7 

Las redes sociales son estructuras que cambian a lo largo del tiempo. Sin 

embargo, la mayoría de los métodos estadísticos que se han desarrollado 

hasta hoy no tratan la evolución de la red. El programa SIENA (Simulation 

Investigation for Empirical Network Analysis) es una herramienta de 

análisis longitudinal de redes sociales que viene a llenar este vacío. SIENA 

ha sido desarrollado en el marco de un programa de investigación sobre “las 

dinámicas de las redes y el comportamiento” liderado por Tom Snijders en la 

Universidad de Groningen, en Holanda, que analiza la mutua dependencia 

de las redes sociales y los comportamientos de los actores. 

SIENA es una plataforma en desarrollo a la que cabe considerar todavía un 

subproducto (a la vez que una herramienta) de investigación, más que un 

software dirigido al usuario promedio. Sin ir más lejos, la aplicación 

StOCNET, que agrupa hasta cinco programas estadísticos diferentes para el 

análisis de redes sociales (incluyendo a SIENA), tiene importantes 

problemas de fiabilidad y “usabilidad”. Sin embargo, por sus características, 

constituye uno de los programas de investigación más prometedores en el 

ámbito del análisis de redes sociales. Concretamente: 

• Permite el análisis longitudinal de las redes sociales. 
• Incorpora herramientas de inferencia estadística. 
• Y facilita el análisis de la mutua dependencia de las redes y el 

comportamiento de los actores. Es decir, las redes pueden ser 
tratadas como variable dependiente o como variable independiente8. 

                                            

6 Autores: Isidro Maya Jariego (Departamento de Psicología Social, Universidad de Sevilla) 
y Ainhoa de Federico de la Rúa (Université de Lille 1). Correspondencia con los autores: 
Isidro Maya Jariego. Departamento de Psicología Social. Universidad de Sevilla. Campus 
Ramón y Cajal. 41.018. Sevilla. Correo-electrónico: isidromj@us.es  
7 Parte de este capítulo fue elaborado por los autores durante la celebración del “Workshop 
Siena”, celebrado en la Universidad de Groningen (Holanda), en enero de 2005, bajo la 
coordinación de Tom Snijders y Christian Steglich. Agradecemos a ambos las orientaciones 
recibidas para la utilización y aprovechamiento del programa.  
8 SIENA analiza simultáneamente los procesos de selección e influencia. Por ejemplo, es 
muy conocido el fenómeno por el que los chicos que fuman en la escuela tienden a asociarse 
entre sí, formando grupos de fumadores. Este hecho puede ser analizado como un proceso 
de selección (“los chicos que fuman suelen hacerse amigos de otros fumadores”) o como un 
proceso de influencia (“los chicos que fuman inducen a sus amigos a fumar”). En el primer 
caso el comportamiento condiciona la red social de los actores, mientras que en el segundo 
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El programa, junto con manuales, artículos y otros materiales, puede 

bajarse libremente del sitio Web:  

http://stat.gamma.rug.nl/snijders/siena.html 

Con este ejercicio realizamos una presentación no técnica del programa 

SIENA. En primer lugar, presentamos el fundamento teórico y las 

potencialidades del modelo estadístico con el que opera el programa. A 

continuación, enumeramos los pasos y operaciones de una sesión básica con 

SIENA. Finalmente, mostramos un ejemplo de aplicación, analizando la 

evolución de los intercambios (de preguntas y respuestas) entre los 

participantes en una lista de correo electrónico. 

EL PROGRAMA SIENA: ESPECIFICACIONES DEL 

MODELO 

SIENA es un programa informático que efectúa la estimación estadística de 

modelos de medidas repetidas de redes sociales. Las tres características más 

destacadas de esta propuesta son (a) el desarrollo de la inferencia 

estadística y (b) la utilización de modelos de simulación, en (c) el análisis de 

la evolución de las redes sociales. Para ello, se basa en el modelo dinámico 

orientado al actor. Veamos a continuación dichas características, repasando 

los presupuestos y los componentes básicos del modelo. 

SIENA trabaja con redes totales o completas. Para ello requiere de dos o 

más matrices, correspondientes a las observaciones en dos o más momentos 

diferentes de una red total determinada. El modelo analiza los factores que 

intervienen en el paso de un estado de la red social al siguiente. Se parte del 

supuesto de que la estructura condiciona su propia evolución, existiendo una 

dinámica por la que los actores pretenden maximizar su utilidad optando 

por establecer, mantener o suprimir relaciones con otros actores. 

                                                                                                                                

es la red social la que influye en el comportamiento. Ambos procesos, en diferente grado, 
pueden estar presentes simultáneamente en esa tendencia a la homofilia en las relaciones, 
y son analizados como un proceso de dependencia mutua en el programa SIENA. 
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La evolución de la red depende de procesos estructurales endógenos, de 

efectos exógenos y de efectos aleatorios: 

1. En primer lugar, la estructura de relaciones tiene una lógica 
endógena, que explica su propia evolución. Por ejemplo, la red puede 
estar experimentando un aumento de la densidad en términos 
generales, puede estar sometida a la lógica de la reciprocidad en las 
relaciones o puede seguir una dinámica transitiva en su evolución. 
Todos ellos son procesos endógenos. 

2. En segundo lugar, la evolución puede obedecer a la influencia de 
variables externas (ya sean individuales o diádicas). Por ejemplo, la 
evolución de la red puede depender de las asociaciones que se 
producen (o no) en función del sexo de los actores, o en función de la 
edad. Es frecuente, por poner un caso, que los actores se asocien 
cuando comparten una característica determinada: la filiación 
ideológica, la procedencia geográfica, el nivel de estudios, etcétera. 

3. Finalmente, el modelo también tiene en cuenta un componente 
aleatorio en la evolución de la red. De esta forma se toma en 
consideración la “variabilidad no explicada”. 

Repasemos someramente algunas de las peculiaridades del enfoque 

estadístico de análisis9. SIENA utiliza simulaciones por ordenador del 

proceso de evolución de la red, basándose en aproximaciones aleatorias. En 

concreto, recurre a procedimientos estadísticos basados en el método de los 

momentos. Se presume que el cambio latente se produce de modo continuo 

entre los períodos analizados. Es recomendable que las dos observaciones 

sean cercanas entre sí, pero que al mismo tiempo reflejen un cambio 

suficiente como para que la dinámica de la red sea susceptible de 

investigación. En su puesta en práctica, los efectos de todas las variables 

incluidas en el análisis se controlan recíprocamente. 

Un paso clave en la aplicación del programa consiste en la especificación del 

modelo, pues nos obliga a seleccionar el conjunto de elementos cuyo efecto 

queremos valorar en la evolución de la red (o, en su caso, en la co-variable de 

comportamiento que queramos introducir). El modelo de SIENA incluye tres 

elementos: 

                                            

9 Para una exposición detallada del modelo estadístico, véase por ejemplo: Snijders (2005), 
Snijders et al. (2005). Una presentación no técnica está disponible en Federico (2004). 
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1. La función de velocidad. Se refiere a la rapidez con la que cambia la 
variable dependiente. Más exactamente refleja la velocidad con la que 
los actores tienen la oportunidad de cambiar en la variable 
dependiente (ya sean sus conexiones en la red o el comportamiento 
que estemos analizando como co-variable). Con este componente del 
modelo se reconoce que la evolución de las redes puede darse con 
ritmos de cambio diferentes. 

2. La función de utilidad. Es el componente central del modelo, e indica 
la satisfacción de los actores con la configuración del vecindario de su 
red local. Se presume que los actores cambian sus conexiones (o el 
comportamiento) para aumentar su satisfacción. 

3. La función de dotación. Establece las diferencias entre el 
establecimiento o la ruptura de lazos. Efectivamente, la función de 
utilidad puede ser diferente dependiendo de que estemos hablando del 
establecimiento de nuevas relaciones o de la ruptura de las mismas. 
Crear o romper un lazo no son acciones inversas en términos de 
satisfacción de los actores. 

Función de utilidad Función de velocidad Función de dotación 
Densidad 
Reciprocidad 
Popularidad 
Actividad 
Transitividad 
Relaciones indirectas 
Equilibrio 
Popularidad /con una 
variable 
Actividad /con una variable 
Similitud /con una variable 
Efectos para variables 
diádicas 

Efecto básico de la velocidad 
Efectos sobre la velocidad 
de: 
- la actividad, 
- la popularidad, 
- la reciprocidad, 
- los atributos de los actores. 
 

Ruptura de relaciones 
recíprocas 
Acceso por relaciones 
indirectas 
Ruptura por variables 
diádicas 
Ruptura por disimilitud 

Tabla 6. Efectos del modelo SIENA 

Nota. No se trata de un inventario exhaustivo. El programa sigue incorporando efectos, 
pero este listado permite una descripción básica del modelo. 

Con este esquema como referencia10, podemos pasar a operar con el 

programa. Ya podemos dar nuestros “primeros pasos” con SIENA. 

                                            

10 El modelo ha ido evolucionando en las sucesivas versiones del programa. El modelo básico 
(la función de utilidad) se ha ampliado con la incorporación de la velocidad y la dotación del 
cambio de la red. El mismo esquema de trabajo para analizar la evolución de la red se ha 
extendido a las co-variables de comportamiento, cuya mutua dependencia se pretende 
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LOS PRIMEROS PASOS CON SIENA: UNA SESIÓN DE 

TRABAJO CON EL PROGRAMA 

Como hemos mostrado en el apartado anterior, SIENA es un programa que 

requiere de un trabajo teórico previo. Por un lado, es necesario conocer los 

tres componentes del modelo que corresponden a la estructura del análisis 

estadístico: la función de utilidad, la función de velocidad y la función de 

dotación. Por otro lado, el modelo sustantivo a contrastar sobre la evolución 

de la red también debe asentarse en el conocimiento teórico previo del 

fenómeno bajo estudio. 

Pero este documento sólo pretende mostrar de un modo sencillo los pasos 

habituales en una sesión con SIENA. Así que a continuación mostramos la 

secuencia de operaciones necesarias para definir y preparar los datos; 

seleccionar los casos que van a ser analizados; especificar el modelo a 

contrastar; e interpretar finalmente los resultados obtenidos. 

1. Stocnet se inicia con la definición de los datos que se van a 

analizar. Se pueden incorporar matrices de redes de relaciones en 

“Network(s)” o características de los actores en “Actor attribute 

file(s)”. 

StOCNET > 

 

                                                                                                                                

analizar. Por otro lado, en los primeros trabajos la función de utilidad era denominada 
“función objetiva” y la función de dotación era denominada “función de gratificación”. 
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Ilustración 66. Interface de entrada en StOCNET 

Con SIENA generalmente utilizamos la red de contactos entre un conjunto 

de actores en dos o más momentos diferentes, por lo que el primer paso suele 

consistir en añadir (“Add”) dos o más archivos con dichos datos. 

 

Data > 
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Y utilizando las opciones “Edit” o “View” podemos observar las matrices de 

datos que vamos a proceder a analizar. 

Edit > or View > 

 

Las matrices utilizadas en este ejemplo están recogidas en el Apéndice I. 

 

2. El segundo paso da la oportunidad de transformar los datos. En 

esta fase podemos recodificar los valores de las variables de nuestro 

estudio, convertir las matrices en simétricas o definir los valores 

perdidos (“missing values”). 

Cuando iniciamos el paso de Transformación de los datos, StOCNET solicita 

previamente un título para el archivo donde se van a guardar de modo 

automático los resultados de nuestra sesión. En nuestro caso hemos elegido 

“Sesion1”. 

Transformation > 
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Ilustración 67. Definición y preparación de los datos 

3. El tercer paso de preparación de los datos nos permite seleccionar 

los casos que vamos a analizar. Podemos seleccionar a todos los 

actores, o a un subgrupo de actores, ya sea un rango de ellos, o de 

acuerdo con una variable o atributo. Generalmente seleccionamos 

“todos” los casos en cuestión. 
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Selection > Select All 

 

Ilustración 68.Selección de los casos a utilizar en el análisis 

4. Finalmente, introducimos las especificaciones del modelo con el 

que vamos a analizar los datos. Primero definimos qué datos y 

variables estarán presentes en nuestro análisis (botón de “data 

specification”). Y a continuación los efectos que queremos analizar con 

el mismo (botón de “model specification”). 

 

Model > 
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Ilustración 69. Especificación del análisis: datos y modelo 

Para empezar con un ejemplo sencillo, podemos introducir dos archivos con 

las relaciones entre un pequeño número de actores en dos momentos 

diferentes. Estarán disponibles aquellos que añadimos en el primer paso. 

Las matrices a analizar las pasaremos a la ventana “Digraphs in seq. 

Order”. De momento, vamos a prescindir de introducir atributos de los 

actores… 

Data specification > Digraphs in seq. order 
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Ilustración 70. Selección de los datos de las redes y de los actores 

El modelo a analizar lo especificamos a continuación. Señalamos en la 

columna “u” (de “utility function”) los efectos de red que queremos estudiar. 

Para el ejemplo, optamos por un modelo simple, con los efectos de la 

densidad, la reciprocidad, el carácter transitivo y la equivalencia estructural 

en la evolución de la red. 

Model Specification > 
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Ilustración 71. Selección de los efectos a contrastar en el modelo 

Ya sólo queda ejecutar el modelo que hemos definido. ¡Le damos a “Run”! 

Run > 
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Ilustración 72. El proceso de estimación 

5. Obtenemos un informe detallado de los resultados. Las 

potencialidades y límites del análisis longitudinal de redes hay que ir 

descubriéndolos poco a poco, pero para empezar hay dos apartados de 

los resultados que nos interesan especialmente. La convergencia del 

modelo, y la significación de los parámetros estudiados. 

Results > 
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Ilustración 73. Ventana que permite acceder a los resultados 

La convergencia nos informa de la adecuación general del modelo. La 

información que aparece organiza en tres columnas consecutivas los 

promedios, las desviaciones tipo y los estadísticos “t”. Cuando estos últimos 

están por debajo de 0.2 podemos considerar adecuado el modelo. Por debajo 

de 0.1 el resultado es muy satisfactorio. Si tenemos valores de 0.3 o mayores, 

conviene repetir el análisis sin cambiar la especificación del modelo, en 

general la convergencia mejorará la segunda vez. 

Convergence information > 
 
Information for convergence diagnosis. 
Averages, standard deviations, and t 
statistics for deviations from targets: 
  1.      0.056    8.022    0.007 
  2.      0.444   10.653    0.042 
  3.      0.026   53.320    0.000 
  4.     -0.027    1.580   -0.017 
 
Good convergence is indicated by the t-
statistics being close to zero. 
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En segundo lugar, valoramos la significación de los parámetros del modelo. 

En cada caso comprobamos si el valor de estimación (primera columna) es 

dos o más veces superior al error estándar (segunda columna), que es más o 

menos el equivalente a un intervalo de confianza del 95%11. En el ejemplo, la 

reciprocidad y el equilibrio estructural parecen tener un efecto en la 

evolución de la red analizada. 

@2 
Estimation results. 
------------------- 
 
Regular end of estimation algorithm. 
Total of 1215 iteration steps. 

 
Estimation Results > 
 
@3 
Estimates and standard errors  
 
 0. Rate parameter of conditioning variable         1.287993  (   0.426689) 
Other parameters: 
 1. u: density (outdegree)                         -1.106880  (   0.554959) 
 2. u: reciprocity                                  1.425366  (   0.484723) 
 3. u: transitivity                                 0.183750  (   0.267330) 
 4. u: balance                                      4.623074  (   2.239667) 

 

No hay que olvidar que SIENA es un programa de simulación y que el 

producto resultante no tiene por qué ser exactamente el mismo en cada 

aplicación, pese a contar con las mismas especificaciones del modelo. Un 

modelo con los mismos parámetros puede producir distintos resultados en 

momentos diferentes. 

                                            

11 Los valores exactos que corresponde a los niveles de significación son respectivamente: si 
1.65 <t< 1.96, p < 0.10; si 1.96 < t < 2.53, p < 0.05; si 2.53 < t < 3.29, p < 0.01; y si t > 3.29, p 
< 0.001. 
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UN EJEMPLO DE APLICACIÓN DEL PROGRAMA: LA 

EVOLUCIÓN DE LOS INTERCAMBIOS EN UNA LISTA DE 

CORREO ELECTRÓNICO 

Veamos un sencillo ejemplo de aplicación de SIENA, analizando la evolución 

de la red de intercambios de preguntas y respuestas en una lista de correo 

electrónico. 

E-Voluntas es una lista de correo sobre “voluntariado, sociedad civil e 

intervención social”. Se trata de un canal para compartir experiencias de 

intervención e investigación sobre voluntariado. Cuenta con unos 300 

subscriptores, de más de 15 países diferentes. Desde su fundación en 

diciembre de 2002, la participación oscila entre 2 y 14 mensajes por semana, 

aproximadamente. 

Analizando quién responde a quién podemos configurar una estructura 

básica de la participación en la lista (Borgatti & Molina, 2002; Maya 

Jariego, 2001). Esto significa prescindir de aquellos mensajes en la lista de 

correo en los que no se da un intercambio persona a persona; haciendo 

abstracción, además, de que los mensajes en la lista son de carácter público 

y ponen en relación (potencialmente) al emisor del mensaje con todos los 

subscriptores de la misma. A pesar de estas limitaciones, la red de mensajes 

y respuestas permite representar la estructura de las relaciones entre el 

grupo de actores más activos en la comunidad virtual. Por ejemplo, en la 

secuencia de sociogramas de la siguiente ilustración (elaborados con 

Netdraw) podemos comprobar cómo evoluciona la estructura de 

intercambios entre los participantes12. 

 

 

                                            

12 Se trata de grafos dirigidos que representan quién responde a quién en E-Voluntas. Cada 
gráfico representa sucesivamente un intervalo más amplio de observación, con un mayor 
número de mensajes. El nivel de conexión se refleja con la intensidad del lazo (con un trazo 
más grueso). Con fines exploratorios agrupamos los nodos de acuerdo con el algoritmo de 
Girvan-Newman (en colores diferentes). 
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Ilustración 74. Secuencia de sociogramas mensajes-respuestas en la lista de 

correo E-Voluntas 

A simple vista, parece que la lista se desarrolla a través de la formación 

paulatina de pequeñas agrupaciones, la emergencia de líderes y la 

organización progresiva de una estructura social de participación. Sin 

embargo, nos interesa conocer de modo más sistemático cuáles son las 

dinámicas presentes en la evolución de esta red social. Por eso procedemos 

recopilando los intercambios en E-Voluntas, en dos intervalos sucesivos de 
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16 meses cada uno13. A continuación, analizamos con SIENA los dos 

momentos observados en la evolución de la red. 

Como recomendación general, resulta práctico comenzar con un modelo 

simple, incorporando más efectos en sucesivos modelos. Aún no siendo la 

única forma de proceder, se puede seguir una aproximación exploratoria en 

la determinación del modelo. Por ejemplo, podemos evaluar en un primer 

paso la incidencia de la densidad y la reciprocidad en la evolución de la red, 

para incorporar en un segundo paso la tendencia a asociarse en función del 

género. Después de una primera aplicación podemos prescindir de los efectos 

no significativos e incorporar otros nuevos. Igual que ocurre con el análisis 

de regresión, determinados efectos pueden ser significativos cuando 

añadimos o eliminamos otros. 

En general, es recomendable iniciar los análisis con una función de 

velocidad constante, y sin efectos de dotación. Por lo que respecta a la 

función de utilidad, el modelo debería incluir siempre la densidad (por 

tratarse de un indicador estructural básico). 

En nuestro ejemplo seguiremos la pauta más simple. Consideraremos sólo 

algunos efectos endógenos en la evolución de los intercambios en E-

Voluntas: 

1. En primer lugar, confeccionamos un modelo con los efectos de (a) la 
densidad y (b) la reciprocidad. 

2. A continuación, y en función de los resultados, comprobaremos la 
existencia de (c) una lógica transitiva en la evolución de la red (“los 
amigos de mis amigos se convierten en mis amigos”), y (d) la 
tendencia a conectarse con aquellos actores más activos en la red. 

                                            

13 Se trata, de hecho, de los 32 primeros meses de funcionamiento de la lista de correo. El 
segundo intervalo se empezó a considerar a partir de la aplicación de la técnica de 
Netmirror (Borgatti & Molina, 2002; Santolaya & Maya Jariego, 2004). Netmirror consiste 
en un procedimiento para representar los intercambios entre un grupo de participantes y 
proporcionarle feedback sobre sus relaciones. Después de reflejar sus relaciones se espera 
un aumento de la participación en la lista y una aceleración de la conformación de una 
estructura centro-periferia. SIENA podría aplicarse con un diseño cuasi-experimental, 
evaluando si las listas de correo donde se ha aplicado Netmirror (V.gr. E-Voluntas) 
experimentan cambios que no se observan en los grupos de control (es decir, en otras listas 
de correo). Sin embargo, para efectos de este capítulo, analizaremos sólo la evolución de la 
red de E-Voluntas. 
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. 

Efecto N T2 AES S.E. S.D. Q (p) 
 
Función de utilidad 
 
Densidad 
Reciprocidad 

       
 
 
 
xx 

N = número de casos en los que se basa el estadístico; T2 = estadístico para calcular el efecto total; 
AES = tamaño del efecto promedio estimado; SE = error estándar; SD = desviación tipo; Q = 
comprobación de la varianza; p = nivel de significación. 

Tabla 7. Resultados del Modelo 1 

 

Efecto N T2 AES S.E. S.D. Q (p) 
 
Función de utilidad 
 
Densidad 
Reciprocidad 
Tripletas transitivas 
Actividad de alter 

       
 
 
 
 
 
xx 

N = número de casos en los que se basa el estadístico; T2 = estadístico para calcular el efecto total; 
AES = tamaño del efecto promedio estimado; SE = error estándar; SD = desviación tipo; Q = 
comprobación de la varianza; p = nivel de significación. 

Tabla 8. Resultados del Modelo 2 

En los primeros 16 meses de funcionamiento de la lista se constituye una 

red muy centralizada. La dinamización de la comunidad virtual depende de 

unos pocos participantes. Por ejemplo, el administrador de la lista es el 

autor del 32 por ciento de los mensajes. Aunque se intuyen algunas 

agrupaciones, la red parece muy dispersa, con cierta dependencia respecto a 

tres nodos vertebradores. De hecho, si retiramos los tres nodos con mayor 

centralidad, la red se disgregaría en ocho componentes separados (Santolaya 

& Maya Jariego, 2004). Se trata en general de un grupo todavía poco 

estructurado. 
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Ilustración 75. E-Voluntas en Tiempo 1 

En el seguimiento, durante los 16 meses siguientes a la primera 

observación, se obtiene una red… 

 

 

AQUÍ GRÁFICO T-2 

Ilustración 76. E-Voluntas en Tiempo 2 
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APÉNDICE I. MATRICES UTILIZADAS EN EL APARTADO 

LOS PRIMEROS PASOS CON SIENA 

(Obsérvese el espacio en blanco antes de cada fila). 

Matriz_tiempo_1.dat 
 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 
 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 
 0 0 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 
 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 
 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 1 0 0 0 1 
 0 0 1 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 1 
 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0 0 
 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1 
 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 1 0 0 0 0 0 1 0 0 0 1 0 0 0 0 

 
Matriz_tiempo_2.dat 
 0 0 0 0 0 0 1 1 0 0 0 1 0 0 0 0 1 1 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 1 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 1 1 1 0 0 0 1 0 0 0 1 0 0 0 1 
 0 0 1 0 0 0 0 0 1 1 1 0 0 0 0 0 0 0 0 0 0 0 1 
 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 1 0 0 0 1 1 0 0 0 0 1 0 0 1 1 0 
 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 
 0 0 0 1 0 0 0 0 0 1 1 0 0 0 0 0 0 0 0 0 0 0 1 
 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1 
 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 0 0 0 
 1 0 0 0 0 1 0 0 0 0 0 0 1 0 0 0 0 0 0 0 1 1 0 
 0 0 0 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 1 1 0 
 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 
 0 0 1 1 0 0 0 0 0 1 1 0 0 0 0 0 0 0 0 1 0 0 0 
 0 1 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 
 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0 
 0 0 1 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 1 0 0 0 0 
 0 0 0 0 0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0 0 1 0 
 0 0 0 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 1 0 0 
 0 0 0 1 0 0 0 0 1 0 0 0 0 0 0 0 0 0 0 1 0 0 0 
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EL ANÁLISIS DEL DISCURSO CON VISONE14 

En muchas aplicaciones del análisis de redes resulta más práctico introducir 

los datos relacionales de forma gráfica, mediante un sociograma, en lugar de 

utilizar una matriz de datos o el formato DL. Una de estas aplicaciones es el 

análisis reticular de textos, y un programa de análisis de redes que permite 

hacerlo es visone, del que nos ocuparemos en este capítulo.  

EL ANÁLISIS RETICULAR DE TEXTOS 

Bajo este nombre podemos englobar un conjunto muy amplio y diverso de 

procedimientos que pretenden representar los discursos como una red de 

significados. La idea es bien sencilla: las palabras, acciones, proposiciones 

…son nodos de un entramado lingüístico que las relaciona. Y esta estructura 

conceptual, discursiva o narrativa puede ser estudiada mediante el análisis 

de redes sociales, mostrando esquemas cognitivos.15  

En particular, el procedimiento con el que se ejemplificará esta aplicación 

será el análisis reticular del discurso basado en la teoría de la 

argumentación en la lengua.  Esta teoría, desarrollada por Anscombre y 

Ducrot (1983), se centra en una relación discursiva llamada topos. Para 

estos autores, un topos es un vínculo entre dos proposiciones 

interdependientes, P y Q, que puede ser vista como una estructura 

argumento-conclusión que da soporte a un enunciado (por ejemplo, si 

alguien dice "he encontrado trabajo porque tenía buenos contactos", desde la 

teoría de la argumentación se diría que este argumento es comprensible no 

tanto por la presencia de la preposición "porque", sino debido al hecho de 

que existe un topos, una creencia socialmente compartida, que relaciona dos 

hechos: el de tener buenos contactos y el de insertarse laboralmente). Con 

algunas reorientaciones, esta herramienta lingüística se ha aplicado 

                                            

14 Autor: Joel Martí (Departament de Sociologia, UAB).  
15 Para más información sobre el análisis reticular de textos consultar Lozares y otros 

(2003). 
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satisfactoriamente al análisis sociológico del discurso (puede encontrarse un 

mayor desarrollo de este método en Martí, 2000). 

El pequeño fragmento de texto con el que trabajaremos en este capítulo 

corresponde a una entrevista realizada a una cajera de hipermercado de 

26 años, a la que se pedía que trazara las grandes etapas de su vida 

(Martí 2000: 160): 

Hombre, yo cuando empecé a trabajar, pues con más libertad 
porque en mi casa, siempre era del instituto a mi casa, no. No tenía 
amigos, no salía apenas. Y te cambia mucho la vida porque ya 
salía, disponía de mi dinero que cambia. Luego enseguida ya..., 
empecé a salir con mi marido. Ya empecé a salir y me cambió la 
vida en ese año, a partir de los dieciocho años, para acá, sí, me ha 
cambiado la vida, es lo que más. Pero al principio era una cría, no 
tengo muchos recuerdos de..., hombre, la etapa del instituto que 
tampoco fue muy buena, porque no tenía amigos y no, lo pasé... Es 
que yo no soy muy comunicativa y lo pasé mal. Luego aquí ya me 
fui abriendo con la gente, también estaba de cara al público, te 
abres más, te haces más sociable...  

La interpretación de este texto nos lleva a la siguiente representación 

gráfica (en tanto que interpretativo, este no es un proceso unívoco y, por lo 

tanto, esta representación no es la única posible):  

 

Ilustración 77. Red discursiva 

Más allá de la secuencialidad de la narración, la observación de la 

estructura discursiva nos permite mostrar su forma a simple vista: este 
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discurso parte del mundo laboral (gracias a éste se obtiene más 

independencia y se aprende a relacionarse con otros), fluye por el ocio (se 

sale, se conoce gente) y desemboca en el ámbito doméstico (una empieza a 

salir por ahí... y termina casándose). En textos más amplios, en los que 

estructuras discursivas más complejas están entrelazadas a lo largo de 

varias argumentaciones, la construcción de un sociograma en el que unas 

relaciones se solapan con otras y se muestran globalmente permite mostrar 

y analizar una red cognitiva global. 

EL PROGRAMA VISONE 

visone16 es un programa pensado especialmente para la representación de 

sociogramas y para su análisis de forma predominantemente visual. Aunque 

no tiene las potencialidades analíticas de otros programas de ARS (éste se 

focaliza específicamente en el análisis de centralidades), su facilidad de 

manejo y sus interesantes representaciones visuales hacen de él una 

herramienta ideal para un estudio exploratorio de datos relacionales. 

Además de las rutinas propias de visualización y análisis, Visone puede 

exportar los datos a otros programas para realizar análisis más detallados, 

como Ucinet.  

PANORÁMICA GENERAL DEL PROGRAMA 

El programa consta únicamente de un archivo de ejecución (Visone.exe) que 

no requiere instalación previa. Al ejecutarlo se abren dos ventanas; la 

principal (fondo en blanco) es la ventana de trabajo, en la que se proyecta la 

red y en la que se encuentran los menús; en la ventana de registro (fondo 

negro) se muestran las operaciones realizadas y los resultados numéricos. 

Los menús del programa son muy intuitivos, por lo que no los explicaremos 

en detalle. En File se encuentran las opciones de gestión de archivos (crear, 

                                            

16 Los orígenes de este programa, liderado por Ulrik Brandes y Dorothea Wagner, se 
encuentran en la Universidad de Konstanz. Está disponible gratuitamente para fines 
académicos y de investigación en la dirección www.visone.info  
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abrir, guardar e importar/exportar); los menús de Nodes y Links nos 

permiten seleccionar y cambiar las opciones de visualización de nodos y 

vínculos. El menú Analysis es el central del programa y nos permitirá 

estudiar gráficamente la distribución de centralidades en la red. Layout y 

View contienen otras posibilidades de visualización. Options es el menú de 

configuración general del programa (rutas de archivos y configuraciones de 

visualización por defecto). El menú de ayuda se encuentra, por ahora, sin 

desarrollar.  

 

Ilustración 78. Ventanas de visone 

La primera vez que cerremos visone, éste creará automáticamente dos 

archivos más en la misma ruta en la que se encuentra el programa. 

Visone.ini es un archivo que contiene las informaciones de configuración 

(rutas y definiciones por defecto del formato de nodos y vínculos definidas en 

el menú Options). Y visone.log es el archivo correspondiente a la ventana de 

registro en el que se guardan los resultados numéricos. Ambos se pueden 

consultar y modificar en un editor de textos. 

Los sociogramas que creemos deberemos guardarlos desde el menú 

File>Save as. Los archivos de visone (con extensión .vsn) conservan la 

información correspondiente a los nodos y vínculos, su formato y su 

ubicación en el plano. 
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CÓMO CREAR SOCIOGRAMAS Y MODIFICAR EL ASPECTO DE NODOS Y 

VÍNCULOS 

Las funciones básicas de creación y desplazamiento de nodos y vínculos se 

realizan en la ventana principal con el botón izquierdo del ratón: 

 Crear un nodo: basta con hacer clic en cualquier lugar de la pantalla y 

aparecerá un nuevo nodo. 

 Crear un vínculo entre dos nodos: Señalar un nodo con el botón 

izquierdo. Al soltar el botón del ratón, el nodo aparecerá sombreado; 

desplazamos el ratón hasta el nodo de destino y hacemos clic encima 

(si se hace en un lugar en blanco de la pantalla, se creará un nuevo 

nodo vinculado al anterior). 

 Mover un nodo: Mantenerlo señalado con el botón izquierdo del ratón 

y arrastrarlo al lugar deseado de la pantalla. 

 Desplazar toda la red en el plano: Basta con señalar con el botón 

izquierdo del ratón en cualquier lugar en blanco de la ventana de 

trabajo y desplazar la red al lugar deseado. 

También se pueden generar sociogramas aleatorios mediante la opción del 

menú File>Generate>Random. En este caso deberá indicarse el número de 

nodos y vínculos deseados. 

En cualquier momento podemos acceder a distintas opciones sobre los nodos 

y los vínculos situando el puntero del ratón encima del elemento haciendo 

clic con el botón derecho (menú contextual). Mediante la opción Setup 

accederemos a un cuadro de diálogo en el que podemos configurar 

características y apariencias de cada uno de los elementos; más adelante 

volveremos a ello. La opción Select nos permite poder seleccionar varios 

elementos (nodos o vínculos) a la vez para poder aplicar determinados 

formatos o acciones de forma conjunta. La opción Delete elimina los 
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elementos seleccionados. En el caso de los vínculos, varias opciones 

adicionales nos permiten cambiar la direccionalidad y valor de la relación.  

 

 

Ilustración 79. Menús contextuales de nodos y vínculos 

Claro que, para empezar, lo mejor es configurar globalmente el programa 

para que los nodos y los vínculos aparezcan, por defecto, con la configuración 

que más nos interese. Para ello acudiremos al menú Options. Lo veremos en 

el siguiente apartado. 

CREACIÓN DE UNA RED DISCURSIVA CON VISONE 

CONFIGURACIÓN GENERAL 

Para representar el ejemplo propuesto de red discursiva, primero deberemos 

cambiar el formato de los nodos para que las etiquetas de texto se puedan 

leer correctamente. Desde el menú Options>Node Defaults... situaremos las 

etiquetas de texto fuera de la figura y estableceremos el texto en negro. 

Pulsaremos el botón Done para activar los cambios y salir del cuadro de 

diálogo. Todos los nodos que generemos ahora tendrán este formato por 

defecto. Para este ejemplo no es necesario modificar las opciones por defecto 

de los vínculos, aunque el procedimiento es análogo (menú: Options>Link 

defaults...).  
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Ilustración 80. Configuración por defecto de los nodos (Options>Node 
defaults...) 

 

Todas estas configuraciones las podemos guardar o restaurar en cualquier 

momento mediante la opción correspondiente. Para cada configuración 

distinta, deberemos crear un nuevo archivo .ini (Options>save settings). 

DIBUJANDO NODOS Y VÍNCULOS 

Una vez definido el formato de los nodos, sólo nos queda dibujarlos en 

pantalla y vincularlos entre ellos. Cada clic que hagamos en la pantalla nos 

creará un nuevo nodo al que Visone atribuye un número; deberemos cambiar 

este número por una etiqueta que corresponda al significado que va a 

reflejar; basta con señalar el nodo en cuestión con el botón derecho (menú 

contextual), ir a la opción Setup y, en el cuadro de diálogo que aparece en 

pantalla, escribir la etiqueta en la opción Label>Name.  
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Importante: Si prevemos la exportación de los resultados a Ucinet, 

deberemos tener en cuenta que las etiquetas que atribuyamos a los nodos 

NO deben tener espacios; de lo contrario, se exportarían incorrectamente. 

Así, el nodo TENER EMPLEO deberá introducirse sustituyendo el espacio por 

un guión bajo o un punto. 

 

Ilustración 81. Etiquetas de los nodos 

Introducimos todos los nodos del ejemplo y las relaciones entre los mismos. 

Por defecto, Visone está configurado para crear relaciones dirigidas y no 

valoradas. Si alguna de estas relaciones fuera bidireccional, basta con 

activar el menú contextual del vínculo en cuestión e indicarlo. Si queremos 

que, por defecto, todos los vínculos que creemos sean no dirigidos, bastará 

con indicárselo así en el menú Options>Link defaults... También podemos 

valorar los vínculos considerando la frecuencia con la que aparecen o su 

intensidad. Por ejemplo, en el caso de que en un texto más largo el vínculo 

entre TENER EMPLEO y SER INDEPENDIENTE apareciera tres veces y nos 
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interesara registrarlo como tal, bastaría con editar las propiedades del 

vínculo en cuestión e indicar que la relación será valorada y el valor que 
tendrá. Posteriormente, en el menú Analysis>Link values, el programa puede mostrar 

estas distintas valoraciones mediante el grosor del vínculo. 

 

Ilustración 82. Relaciones valoradas 

VISUALIZACIÓN Y ANÁLISIS DE LA RED 

ANÁLISIS BÁSICOS 

El menú Layout nos ofrece distintas opciones de visualización, pero en 

visone destacan sobretodo las rutinas de análisis/visualización contenidas el 

el menú Analysis. 

Si accedemos a Analysis>Degree, veremos como visone cambia 

automáticamente la forma de los nodos: a mayor grado nodal de entrada 

(indegree), la figura es más alta; a mayor grado nodal de salida (outdegree), 

la figura es más ancha.  
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Ilustración 83. Grado nodal 

Si queremos ver los resultados numéricos, basta con consultar la ventana 

de registro, o bien editar directamente el archivo visone.log. A diferencia 

de otros programas que ofrecen valores absolutos y estandarizados de los 

índices, Visone los reescala en porcentajes sobre el total. 

node                      degree   indegree  outdegree 
TRATAR.CON.CLIENTES      6.2500%    0.0000%   12.5000% 
TENER.EMPLEO             6.2500%    0.0000%   12.5000% 
CASARSE                  6.2500%   12.5000%    0.0000% 
SER.INDEPENDIENTE       12.5000%   12.5000%   12.5000% 
HABILIDADES.RELACION    12.5000%   12.5000%   12.5000% 
SALIR                   18.7500%   25.0000%   12.5000% 
TENER.PAREJA            18.7500%   25.0000%   12.5000% 
TENER.AMISTADES         18.7500%   12.5000%   25.0000% 
 
minimum                  6.2500%    0.0000%    0.0000% 
maximum                 18.7500%   25.0000%   25.0000% 
 
centralization           7.1429%   14.2857%   14.2857% 
density 14.2857% 

Visone nos ofrece un índice de centralidad muy interesante para redes 

textuales: el PageRank. PageRank es un indicador introducido y utilizado 

por la empresa Google (Brin y Page, 1998) para indexar la importancia de 

las páginas web. Explicado de forma intuitiva: se trata de atribuir puntos 

a aquellas páginas (nodos) que son enlazadas por otras (cuanto más 

enlaces lleven a una página, más importante será ésta); a su vez, estos 

puntos son ponderados por la importancia que tienen las páginas que 

contienen los enlaces. En una red de significados, el PageRank puede ser 
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interpretado como un indicador de accesibilidad de los nodos, es decir, del 

grado en que un significado es accedido por el resto; los valores altos de 

PageRank nos suelen indicar los “puntos de llegada” más centrales de los 

discursos. En cambio, los valores bajos nos dan buenas pistas de cuales 

son los “principios motores” de los discursos, aquellas acciones o 

significados que desencadenan el resto. Veamos como se distribuyen estos 

valores en el ejemplo, desde el menú Analysis>PageRank. 

 

 

Ilustración 84. PageRank  

 

Vemos como los nodos con valor de PageRank más altos (los más 

accesibles) son TENER PAREJA y CASARSE: se sitúan aquí como nodos 

finalistas, puntos de llegada del discurso (la propia representación gráfica 

muestra como parece que todo el discurso “fluye” hacia allí). Los nodos 

con un PageRank más bajo son los referidos a la actividad laboral, y 

muestran como ésta es el motor o generador del resto, porque es la que 

acaba “enlazando” con la boda. 
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Otro índice que nos ofrece una información interesante es la 

intermediación (betweenness). La centralidad de intermediación nos 

indica qué nodos son más estratégicos, porque se sitúan como puente 

entre unos y otros. Si accedemos a esta representación desde el menú 

Analysis>Betweenness, observamos como en el caso del ejemplo estos 

nodos corresponden al mundo relacional, que se situaría aquí como 

mediador entre la actividad laboral y el ámbito doméstico. 

 

 

Ilustración 85. Betweenness 

MÁS POSIBILIDADES 

Además de los anteriores, el programa permite el cálculo/visualización de 

otros índices de centralidad. Todos ellos se encuentran definidos en un 

artículo de los autores disponible en red (Brandes y Wagner, 2003). 

Por otro lado, en muchos casos el interés del análisis es poder comparar 

distintos textos o discursos. Utilizando el mismo método, los grafos 

adjuntos muestran la estructura discursiva de dos editoriales de 

periódicos españoles, El Mundo y El Periódico de Catalunya, sobre el 

hundimiento de un túnel de metro en Barcelona y el posterior conflicto 
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político que se generó por acusaciones de corrupción entre grupos políticos 

(la llamada “crisis del 3%”). Se observa cómo para El Mundo, de línea 

conservadora, la noticia es la crisis política desencadenada en el gobierno 

de izquierdas, y cómo lo que origina esa crisis son los dos principales 

fantasmas de este periódico en Cataluña: el gobierno de Maragall 

(responsable de aprobar las obras que dieron lugar al hundimiento) y la 

presencia del partido independentista ERC en el mismo (que conlleva 

nerviosismo y mala gestión de la crisis). El tratamiento de los mismos 

hechos es bien distinto en El Periódico de Catalunya, defensor de las tesis 

gubernamentales: la noticia principal es la salida a la luz del cobro de 

comisiones ilegales por parte del gobierno anterior (la crisis política es 

sólo un elemento derivado de esta acusación). Para esta editorial los 

cobros son, en última instancia, los causantes de la reducción de costes de 

obra que ha provocado el hundimiento; con lo que se justifica que, 

amparado en la inmunidad parlamentaria, el Gobierno catalán haya 

hecho estas acusaciones a la oposición. 

El Mundo * El Periódico de Catalunya * 

  

* Editoriales del 25/02/2005 (www.elmundo.es) y 27/2/2005 (www.elperiodico.com). 

Ilustración 86. Comparación de dos editoriales por Degree y PageRank 
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El método expuesto aquí, basado en la identificación de vínculos tópicos, 

es sólo uno de los muchos posibles. Serán los objetivos del análisis y los 

supuestos metodológicos los que lleven a definir el procedimiento de 

análisis reticular de textos más pertinente. La siguiente ilustración 

muestra un mapa conceptual de Visone realizado desde el método del 

Centering Resonance Analysis (Corman y otros, 2002), basado en la 

proximidad de palabras en el texto. Se trata de un análisis de noticias de 

Reuters durante el primer día de los atentados del 11-S en Nueva York, 

basado en un grafo inicial de más de 2400 nodos de los que se extrajeron 

los 42 más centrales (Batagelj y otros, 2002; citado en Brandes y Wagner, 

2003). 

 
Ilustración 87. Análisis de las noticias de Reuters en los atentados del 11-S*  

* Extraído de  Brandes y Wagner (2003), pág. 17 

SALIDAS Y EXPORTACIÓN DE RESULTADOS 

Visone no permite imprimir directamente, pero las visualizaciones se 

pueden exportar sin ningún problema a cualquier otro programa. Además de 

la opción más “artesanal” de copiar el gráfico con cualquier capturador de 
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pantallas y guardarlo en el formato que más nos convenga (BMP, JPG...), 

podemos exportar la imagen a formatos de alta calidad como Postscript (PS) 

o Scalable Vector Graphics (SVG), aunque éste último puede presentar en 

ocasiones defectos de conversión. Estas opciones se encuentran en el menú 

File>Export. 

Con respecto al archivo de registro y resultados, basta con abrirlo en un 

editor y copiar la parte que deseemos en un procesador de textos. 

También nos puede interesar exportar los resultados a otros programas de 

análisis de redes para realizar análisis más detallados. Veremos un ejemplo 

de exportación hacia Ucinet. Para ello, la opción más recomendable es 

transformar el formato de Visone (VSN) a formato DL para abrirlo con 

Ucinet y, desde ahí, convertirlo a archivos ##D / ##H. Deberemos hacerlo en 

dos pasos: 

1) Exportación de Visone a DL. Después de haber guardado la versión 

definitiva del archivo en Visone, guardarlo en formato DL desde el 

menú File>Export>DL file. 

 

Ilustración 88. Exportación de datos desde Visone  
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2) Importación de formato DL a Ucinet (.##d). Ejecutar Ucinet y, desde la 

pantalla principal, acceder al menú Data>Import>DL. En el cuadro de 

diálogo que nos aparece, deberemos explorar e introducir el nombre de 

archivo DL. Automáticamente, Ucinet atribuirá el mismo nombre al 

archivo de salida, pero esta vez en el formato propio del programa. 

 

Ilustración 89. Importación de datos desde Ucinet 

La matriz está lista para ser analizada con Ucinet: 

 

Ilustración 90. Output del fichero de datos importado 
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